Acronis®
vmProtect™ 6

User Guide
# Table of contents

1. **Introducing Acronis vmProtect 6.0** ........................................................................................................5  
2. **Acronis vmProtect 6.0 Overview** ........................................................................................................6  
   2.1 **Acronis vmProtect Features** ........................................................................................................6  
3. **How Acronis vmProtect 6.0 Works** .....................................................................................................7  
   3.1 **Virtual machines backup and restore** ............................................................................................7  
   3.2 **Backup archive structure** ..............................................................................................................7  
   3.2.1 **Multiple files backup scheme (Legacy mode)** .........................................................................7  
   3.2.2 **Single file backup scheme (Always Incremental mode)** ..........................................................8  
4. **Installation of Acronis vmProtect 6.0** ................................................................................................9  
   4.1 **Requirements** ...............................................................................................................................9  
   4.1.1 **Supported operating systems** .................................................................................................9  
   4.1.2 **System requirements** .............................................................................................................9  
   4.1.3 **How to install VMware Tools** ................................................................................................10  
   4.2 **Installation options** ....................................................................................................................10  
   4.2.1 **Installing Acronis vmProtect 6.0 as Virtual Appliance on an ESX(i) host** ................................11  
   4.2.2 **Installing Acronis vmProtect 6.0 as Windows Agent** ..............................................................12  
   4.2.3 **Extracting installation files** .....................................................................................................14  
   4.2.4 **Configuring ESX(i) host connection settings** .......................................................................15  
   4.2.5 **Using a locally attached storage** .............................................................................................15  
   4.3 **Uninstalling Acronis vmProtect 6.0** ............................................................................................15  
5. **Getting started** ....................................................................................................................................17  
   5.1 **Dashboard Management** .............................................................................................................18  
   5.2 **Using Web Console** ....................................................................................................................19  
   5.2.1 **Ribbon tabs** ............................................................................................................................19  
   5.2.2 **Logout link** ..................................................................................................................................22  
6. **Creating a Backup of Virtual Machines** ............................................................................................23  
   6.1 **What to Back Up** ..........................................................................................................................23  
   6.2 **Where to Back Up** ........................................................................................................................23  
   6.3 **When to Back Up** .........................................................................................................................25  
   6.4 **How to Back Up** ...........................................................................................................................26  
   6.4.1 **Backup type** ............................................................................................................................26  
   6.4.2 **Retention rules** .......................................................................................................................27  
   6.4.3 **Backup validation** ...................................................................................................................30  
   6.4.4 **Other settings** ........................................................................................................................30  
   6.4.5 **Completing the Create backup task wizard** .........................................................................30  
6.5 **Options** ............................................................................................................................................30  
   6.5.1 **Archive Protection** ...................................................................................................................30  
   6.5.2 **Source Files Exclusion** ...........................................................................................................31  
   6.5.3 **Compression Level** ...............................................................................................................31  
   6.5.4 **Error Handling** .....................................................................................................................31  
   6.5.5 **Notifications** ..........................................................................................................................32  
   6.5.6 **Additional Settings** ...............................................................................................................33  

Copyright © Acronis, Inc., 2000-2011
6.6 Managing created backup task

7 Restoring a Backup of Virtual Machines

7.1 What to restore
7.2 Where to restore
7.3 How to restore
7.4 Options

7.4.1 Notifications
7.4.2 Error Handling
7.4.3 VM power management
7.4.4 Additional Settings

7.5 Managing created restore task

8 File Recovery

8.1 What to Recover
8.2 Explore Recovery Point

9 Running VM from Backup

9.1 What VM to Run
9.2 Where to Run the VM
9.3 Additional Settings
9.4 Managing created “Run VM from Backup” activity

10 Managing Tasks

10.1 Running a task
10.2 Cancelling a task
10.3 Editing a task
10.4 Deleting a task
10.5 Viewing task logs

10.6 Viewing task details

10.6.1 Summary tab
10.6.2 Source tab
10.6.3 Target tab
10.6.4 Options tab

11 Managing Recovery Points

11.1 Adding a backup location
11.2 Virtual Machines catalog
11.3 Recovery Points list
11.4 Summary tab

11.5 Operations on selected items

11.5.1 Restore
11.5.2 Run VM from backup
11.5.3 File recovery
11.5.4 Validate
11.5.5 Delete
12 Other Operations .................................................................................................................. 64
12.1 Validating backups (Actions -> Validate) ......................................................................... 64
12.1.1 What to validate ........................................................................................................... 64
12.2 Managing mounted VMs (View -> Mounted VMs) .......................................................... 66
12.2.1 Mounted VMs list ........................................................................................................ 67
12.2.2 Mounted VMs details .................................................................................................. 67
12.2.3 Unmounting VMs ....................................................................................................... 68
12.3 Managing logs (View -> Show Logs) ................................................................................ 68
12.3.1 Logs list ....................................................................................................................... 68
12.3.2 Log cleanup rules ...................................................................................................... 69
12.3.3 Clear logs .................................................................................................................. 70
12.3.4 Save logs to file ......................................................................................................... 71
12.4 Managing licenses (Configure -> Licenses) ...................................................................... 71
12.4.1 Adding license ............................................................................................................ 72
12.4.2 Adding license failure ............................................................................................... 74
12.4.3 Removing license/ESX host ...................................................................................... 74
12.5 Managing ESX hosts (Configure -> ESX hosts) ............................................................... 75
12.5.1 ESX hosts list ............................................................................................................. 75
12.5.2 Adding ESX host ....................................................................................................... 76
12.5.3 Adding an ESX host which is a part of vCenter ......................................................... 77
12.5.4 Login credentials ..................................................................................................... 77
12.5.5 Removing ESX host ................................................................................................. 78
12.6 Managing settings .......................................................................................................... 79
12.6.1 Managing Online Backup Proxy .............................................................................. 79
12.6.2 Managing Agent Password ..................................................................................... 81
13 Best Practices ...................................................................................................................... 82
13.1 Backing up virtual machines to a network share .......................................................... 82
13.2 Restoring a backup of a virtual machine to a new location ........................................... 82
13.3 File/folders recovery .................................................................................................... 83
14 Support .................................................................................................................................. 84
14.1 Technical Support ......................................................................................................... 84
14.2 Troubleshooting ............................................................................................................ 84
15 Glossary .............................................................................................................................. 85
1 Introducing Acronis vmProtect 6.0

Acronis believes that virtualization and transition to the cloud are not only a better way of doing computing, but also allow for achieving less downtimes and faster recoveries while reducing costs. Unfortunately, most of backup and recovery solutions are designed for physical systems and are either not good enough for virtual environments or do not allow for all of the benefits and savings that virtualization could potentially give.

Acronis is firmly committed to helping its customers and channel partners get most of virtualization, and intend to set a new standard of backup and recovery in virtualized environments through:

- Reducing IT operating and maintenance costs to help business performance by providing technology that is easy to use and easy to implement.
- Minimizing overhead and getting most benefits from VMware vSphere environments by providing a backup and recovery solution specially designed for virtualized environments.
- Minimize risk of data loss by storing backups offsite in Acronis Online Storage.
2 Acronis vmProtect 6.0 Overview

Acronis vmProtect 6.0 is a comprehensive backup and recovery solution designed for VMware vSphere™ environments. It enables organizations to perform an agent-less backup of entire ESX or ESXi virtual machines with the ability to recover entire machines or individual files and folders.

2.1 Acronis vmProtect Features

Using Acronis award-winning imaging technology, Acronis vmProtect 6.0 creates an exact image (backup) of the virtual machine, including guest operating system, configuration files and applications, resource pool/vApp properties and datastore settings. It then provides you with the ability to recover this backup to either the original ESX / ESXi host or to a new one. The ability to start a virtual machine directly from a backup without performing an actual restore, making the VM operational after a failure in a few seconds, is one of the key new features.

Other new features include:

- An option to choose between virtual appliance or Windows-based installation.
- Web-based easy-to-use user interface.
- LAN-free backup with direct access to shared storage.
- Instantly run a VM from a backup on an existing ESX or ESXi host for quick recovery.
- New enhanced storage format for backups optimized for always incremental strategy.
- Simultaneously back up several virtual machines.
- Support for vApp/resource pool settings backup/restore.
- Change Block Tracking (CBT) support.

Main advantages of using Acronis vmProtect 6.0 are:

1. **Ease-of-use.** Acronis vmProtect can be deployed either as virtual appliance or installed on a Windows machine and is managed via brand new web-based interface. Given huge Acronis experience in designing intuitive GUIs and focused target on VMware – the interface allows starting right away without a need to investigate or read documentation, and avoids dangerous mistakes or misconfiguration.

2. **More functionality.** In addition to standard backup and restore features, vmProtect includes unique functionality, such as: running virtual machine directly for backup; unlimited number of P2V conversions; backup to cloud-based Acronis Online Storage; industry-standard 256-bit encryption to protect backups.

3. **Low Total Cost of Ownership (TCO).** vmProtect is priced per CPU, and a list prices is quite cheap. Virtual Appliance does not require a dedicated machine or Windows license to operate, plus a reliable and intuitive solution saves administrator’s time and management cost.

4. **Safe investments by working with established vendor.**
3 How Acronis vmProtect 6.0 Works

3.1 Virtual machines backup and restore

As with a physical machine, your virtual machine (or several VMs as a whole virtual infrastructure) should also be protected. Once you have installed Acronis vmProtect 6.0 agent, you can:

- Back up a virtual machine or multiple virtual machines residing on the server without having to install additional software on each virtual machine.
- Recover a virtual machine to the same or another virtual machine residing on the same server or on another virtualization server. The virtual machine configuration stored in a virtual machine backup and the virtual disks data will be restored to a new virtual machine.

A virtual machine can be online (running), offline (stopped), suspended, or switched between the three states during backup.

A virtual machine has to be offline (stopped) during the recovery to this machine. The machine will be automatically stopped before recovery. You can opt for manual stopping of machines.

The detailed information can be found in the "Creating a backup of virtual machines" (p. 23) and "Restoring a backup of virtual machines" sections (p. 35).

3.2 Backup archive structure

Acronis vmProtect allows you to create the backup of virtual machines by using one of the two backup archive schemes: Multiple files backup scheme (Legacy mode) or Single file backup scheme (Always Incremental mode).

In Acronis vmProtect, the Single file backup scheme is set as the default.

3.2.1 Multiple files backup scheme (Legacy mode)

With this scheme, the data for each backup is stored in a separate archive file (.tib extension). A full backup is created at the first launch. The following backups are performed according to the incremental method.

Set up the backup retention rules and specify the appropriate settings. The outdated backups, i.e. backups older than the designated number of days (defined by the retention rules) are deleted dynamically in compliance with the following procedure:

Note that it is not possible to delete a backup which has dependencies. For example, if you have a full backup plus a set of incremental backups, you cannot simply delete the full backup. If you do, the incremental backups will not be recoverable. The backups which become subject to deletion (according to the retention rules) will not be deleted until all the dependent backups also become deletable. This limitation can be overcome by utilizing the Always Incremental backup mode.
3.2.2 Single file backup scheme (Always Incremental mode)

Usually, backups are kept only for a certain time period (retention time) or there is a policy to keep only the last X backups in the backup chain. Backup archives are managed on a daily, weekly, etc. basis. The main limitation of the Legacy mode backup archive is that you cannot delete a random backup from the backup chain since it may have dependencies on it from subsequent backups. This is where Always Incremental backup archive can help.

Always Incremental mode uses a new generation archive format which may contain several backups from a number of virtual machines. After the first full backup, all other backups are saved to this archive in incremental mode. Physically all data is located inside one file as opposed to the Legacy archive format where each backup is stored in a separate .tib file. Therefore, unlike the Legacy mode archive, it is possible to delete a random backup from Always Incremental archive even if it has dependencies.

When a certain backup expires due to the pre-defined retention rules (for example to “delete the backups if they are older than 2 days”), the backup algorithm just marks these outdated backup blocks as “free” ones.

The blocks of expired backups with dependencies (which are needed to restore the newer backups) are not marked as “free” to ensure the archive consistency. Everyday, the archive should contain data that is not older than two days in order to restore the backup (retention time). This is the basic rule of the Always Incremental archive. All excessive data in the archive is marked for deletion, i.e. as “free” space. The initial archive still occupies the same space on the storage as before, however all newer backups will be written to the “free” blocks first, and only if all the “free” blocks are filled, the total size of the archive will be increased.

This approach allows keeping the archive size as small as possible and prevents it from excessive growing. Also, the implementation of this backup scheme significantly saves time and resources for managing the backups inside the archive because the “free” blocks marking is almost an instant operation. Thus, the limitations of the Legacy archive mode are no longer true for Always Incremental archive.

The Always Incremental archive total size includes the size of the “used” blocks and the size of the “free” blocks. Usually, the size of the Always Incremental archive does not grow indefinitely and stays within the total size of the backups you want to keep.
4 Installation of Acronis vmProtect 6.0

4.1 Requirements

4.1.1 Supported operating systems

Acronis vmProtect supports the following operating systems:

- Windows XP Professional SP3 (x86, x64).
- Windows Vista - all editions (x86, x64).
- Windows 7 - all editions (x86, x64).

4.1.2 System requirements

The components installed in Windows:

<table>
<thead>
<tr>
<th>Edition name</th>
<th>Memory (above the OS and running applications)</th>
<th>Disk space required during installation or update</th>
<th>Disk space occupied by the component(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmProtect</td>
<td>80 MB</td>
<td>1 GB</td>
<td>500 MB</td>
</tr>
</tbody>
</table>

To perform each task (Backup, Restore, RunVM, Validate, etc.) the Agent needs about 100Mb of memory. Acronis vmProtect could perform parallel tasks (such as parallel backup tasks, etc) of up to 5 tasks at a time. If more than 5 tasks are run simultaneously, the Agent will process only the first 5 tasks, while the other tasks will remain in the queue with the "waiting" status.

Also, note that Acronis vmProtect 6.0 reserves and always uses the following system TCP ports: 111 (sunrpc), 9000 (WCS), 764 (nfs_server), 9876 (Remote Agent Service).

Here is a list of supported environments for Acronis vmProtect 6.0:

- VMware vSphere (Virtual Infrastructure).
- Server types: ESX and ESXi.
- Versions: 4.0, 4.1, 5.0.
- Editions/Licenses.
  - VMware vSphere Standard (Hot-add is NOT supported).
  - VMware vSphere Advanced.
  - VMware vSphere Enterprise.
  - VMware vSphere Enterprise Plus.
  - VMware vSphere Essentials.
  - VMware vSphere Essentials Plus.
  - VMware vSphere Hypervisor (Free ESXi is NOT supported).
For the smooth operation of the Acronis vmProtect Web Console, you should have one of the following versions of your web browser:

- Mozilla Firefox 3.6 or higher.
- Internet Explorer 7.0 or higher.
- Opera 10.0 or higher.
- Safari 5.0 or higher.
- Google Chrome 10.0 or higher.

### 4.1.3 How to install VMware Tools

Acronis vmProtect requires the installation of VMware Tools. To install the VMware Tools:

- Run the VMware Infrastructure/vSphere Client.
- Connect to the ESX server.
- Select the virtual machine and run the guest operating system.
- Right click the virtual machine and select Guest -> Install/Upgrade VMware Tools.
- Follow the onscreen instructions.

Note that the Run VM from backup feature requires VMkernel networking to be configured on the ESX server. This can be done in vSphere client by going to Configuration -> Networking and adding VMkernel connection type to the vSwitch properties.

### 4.2 Installation options

The very first thing you have to do is to install Acronis vmProtect software, configure your ESX(i) host connection settings and set up your access credentials to Acronis vmProtect web console.

When you run your Acronis vmProtect installation package, the installation menu appears. Acronis vmProtect has three main installation options:

- **Install Acronis vmProtect 6.0 as Virtual Appliance on an ESX(i) host.**
- **Install Acronis vmProtect 6.0 as Windows Agent.**
- **Extract installation files.**

The first two options allow you to install the software on a remote ESX(i) host (see Installing Acronis vmProtect 6.0 as Virtual Appliance on an ESX(i) Host (p. 11)) or install Acronis vmProtect software on your local PC (see Installing Acronis vmProtect 6.0 as Windows Agent (p. 12)). The third option allows you to extract the installation files (see Extracting installation files (p. 14)) and perform either Acronis vmProtect remote deployment or local installation manually with the help of standard installation tools.

Acronis vmProtect Virtual Appliance deployment to an ESX host is a better choice if your infrastructure is fully virtualized.

Acronis vmProtect Windows Agent installation on your local PC is a preferable choice if you have a physical computer available to be used as a console for managing all vmProtect functionality.

If you would need to manage or troubleshoot your Virtual Appliance / Windows Agent installation without the default installer or if you would need to install only a certain component without carrying out the full installation procedure, you can always choose to extract the installation files.
4.2.1 Installing Acronis vmProtect 6.0 as Virtual Appliance on an ESX(i) host

Acronis vmProtect software could be installed directly on an ESX(i) host. The process of remote installation of Acronis vmProtect Virtual Appliance to an ESX(i) host is called deployment. The software for running all necessary Acronis services will be installed on a separate small virtual machine under a specially customized OS (small Linux distribution).

1. First, read the Acronis vmProtect license agreement, select the acceptance check box and then click Next.

2. Specify the desired ESX(i) server or vCenter access credentials: IP address or hostname, your user name and access password. When you click Next, the installer will automatically check the connection and go through the authorization procedure.

3. Then the installer will check for previous versions of Acronis vmProtect or any other Acronis software on the specified ESX(i) server. If you already have the Acronis Virtual Appliance set up there and it is outdated, then the installer would prompt you to update it to the latest version or create the new Virtual Appliance.

4. Set your Appliance (VM) name, choose the ESX(i) host and datastore as a target for deploying the Acronis vmProtect software. You can change the Appliance name or keep the default one. The Appliance name should be unique within the ESX(i) host. If you set the vCenter and its credentials on the previous installation step, you have to choose one of the ESX(i) hosts contained in that vCenter from the respective drop-down list. Otherwise, there will be no choice and you will see your direct ESX(i) host.

Then, select the datastore on that specific ESX(i). If the space on that datastore is not enough for installation, you will get the warning suggesting that you free up some space on the selected datastore or choose another one. There can be only one unique Virtual Appliance with the specified name on the specified datastore. If the Appliance name already exists there, you will have to change either your Appliance name or the datastore.

5. Provide the information on the network settings for your Virtual Appliance. This step contains standard network settings like IP address, subnet mask, default gateway, DNS server settings, etc. You can also let the appliance acquire the network settings automatically, which is the default option.

6. The next step prompts you to accept or ignore your participation in the Acronis Customer Experience Program.

7. After going through all the required steps of the installation wizard, you will finally see the summary information of the deployment operations to be performed – components to be installed, required space, account information and chosen destination (host and datastore).

Then the Acronis vmProtect installer deploys the Virtual Appliance software. You will see the progress bar with the current installation step indicated. After the deployment is finished successfully, the appliance is started automatically. Please, wait until the whole process is completed and everything is checked. This may take several minutes.

If the installation process finished successfully and all Acronis vmProtect components were successfully deployed, you will get the "Deployment has been completed" page. Here, select the check box if you wish to run the Acronis vmProtect Web Console (it will be opened in the default Internet browser) to connect to your newly deployed Acronis vmProtect Virtual Appliance. Then click Close. The default login:password for the Acronis vmProtect Web Console is root:root. Note that you
cannot change the login for your Web Console. To change the Web Console password, go to Configure->Agent Password page (for more information refer to Managing Agent Password section (p. 81)).

If there is any problem, the Virtual Appliance (parts of it which have already been deployed during the installation) will be removed from ESX(i) automatically. You will get the "Failed to install vmProtect components" page. Here, you can see the summary information on the installed and failed to install components. Show log link opens up a pop-up with the detailed information, and Troubleshoot link opens the online page with the particular error description on the Acronis Knowledge Base website at http://kb.acronis.com. If you still cannot find the answer on how to solve this problem, please, contact the Acronis support team (p. 84).

4.2.2 Installing Acronis vmProtect 6.0 as Windows Agent

If your production ESX(i) hosts are so heavily loaded that running the virtual appliances is not desirable, consider installing Acronis vmProtect Windows Agent on a physical machine outside the ESX(i) infrastructure.

If your ESX(i) uses a SAN attached storage, install the agent on a machine connected to the same SAN. The agent will back up the virtual machines directly from the storage rather than via the ESX(i) host and LAN. This capability is called a LAN-free backup.
The diagram below illustrates a LAN-based and a LAN-free backup. LAN-free access to virtual machines is available if you have a fibre channel (FC) or iSCSI Storage Area Network. To completely eliminate transferring the backed up data via LAN, store the backups on a local disk of the agent’s machine or on a SAN attached storage.

Acronis vmProtect Windows Agent can be installed on any machine that runs Windows and meets the system requirements. Here is a brief description of the steps you need to go through in order to complete your Windows Agent installation.

1. First, read the Acronis vmProtect license agreement, select the acceptance check box and then click Next.

2. Specify credentials for the Acronis services. The Acronis Managed Machine Service component (responsible for the core functionality of Acronis vmProtect) runs as a service. Specify the account under which the component's service will run after the installation (this account will be automatically granted with “Log on as service” permissions on the machine). Here you should provide the credentials of any Windows user which has “Log on locally” permissions on the machine with the Agent installed. Typically, this can be any user account from “Administrators”, “Power Users” or “Users” group. Set the HTTPs port, e.g. the default 9877 port. For access to Acronis web console page after Acronis vmProtect Agent is installed, open your web browser and enter “https://myserver:port” in the browser address bar.

   Note that in order to successfully connect to your installed Agent through the browser (web console), the name of your local PC where Acronis vmProtect is installed should not contain an underscore (_) symbol. You should provide the credentials of any user with Administrator privileges on the machine.
3. Select the way you want your components to be installed, i.e. specify the location where to install the software. The default destination for installing Acronis vmProtect is the C:\Program Files\Acronis folder. You can change the destination by typing in a new folder name or selecting it by browsing. If the folder does not exist, it will be automatically created in the process of installation. The Disk usage button shows the available disk space for the different volumes on your PC and helps you to choose the target disk for installation. If there is not enough free space on the selected volume, you’ll be prompted to free up the required space or select another volume. Upon specifying the desired destination, click Next.

4. Please, read the information about the Acronis Customer Experience Program, choose if you want to participate in it or not, and then click Next. The main purpose of ACEP is to help us collect user statistics in order to improve our software functionality, customer service and customer experience.

5. After going through all the required installation wizard steps, you will finally see the summary information of the install operations to be performed, components to be installed, required space, account information and chosen destination.

6. Click Install to start the process. You will see the Acronis vmProtect installation progress bar. During installation, Windows Firewall may prompt you to unblock TCP/IP ports. This is required for the appliance to operate properly. To unblock, in the opened Windows Firewall dialog box click the Unblock button. Please, wait until the installation is finished. It may take several minutes.

If the installation process finished successfully and all Acronis vmProtect components were successfully installed, you will get the "Installation has completed" page. Here select the check box if you wish to run Acronis vmProtect Web Console and click Close.

If the installation process fails and all or some of the Acronis vmProtect components for any reason could not be successfully installed, you will get the "Failed to install vmProtect components" page. Here you can see the summary information on the installed and failed to install components. Show log link opens up a pop-up window with the detailed information, and Troubleshoot link opens the online page with the particular error description on the Acronis Knowledge Base website at http://kb.acronis.com. If you still cannot find the answer how to solve this problem, please contact the Acronis support team (p. 84).

4.2.3 Extracting installation files

Acronis vmProtect installation package provides you with the option to extract the installation files on your PC to be executed manually and to be installed by the standard tools.

Click the Extract installation files of the Acronis vmProtect installation main menu. Select the desired components to be saved as separate installation files on your PC:

- Acronis vmProtect .msi – the main installation file for Acronis vmProtect Windows Agent.
- AcronisESXAppliance.ovf and two .vmdk files – installation files for Acronis vmProtect Virtual Appliance.
Specify the location you want to extract your files to, and then click Extract. The Disk usage button shows the available space for the different volumes on your PC and helps you to choose the destination disk for the files extraction.

Close the dialog when the extraction process is completed.

4.2.4 Configuring ESX(i) host connection settings

For detailed information on setting and configuring your ESX(i) host connection credentials, please refer to Managing ESX hosts (p. 75) section.

4.2.5 Using a locally attached storage

You can attach an additional disk to an Agent for ESX(i) (Virtual Appliance) so the agent can back up to this locally attached storage. Such backup is normally faster than backup via LAN and it does not consume the network bandwidth. We recommend using this method when a single virtual appliance manages the entire virtual environment residing in a SAN attached storage.

You can add the storage to an already working agent or when importing the agent from an OVF template.

To attach a storage to an already working agent

1. In VMware vSphere inventory, right click the Agent for ESX(i) (Virtual Appliance).
2. Add the disk by editing the settings of the virtual machine. The disk size must be at least 10 GB.
   Be careful when adding an already existing disk. Once the storage is created, all data previously contained on this disk will be lost.
3. Go to the virtual appliance console. The Create storage link is available at the bottom of the screen. If it is not, click Refresh.
4. Click the Create storage link, select the disk and specify a label for it.

Details. The label length is limited to 16 characters due to file system restrictions.

To select a locally attached storage as a backup destination

When creating a backup task, in Where to back up->Browse dialog expand the Local Folders item and choose the locally attached storage drive, for example D:\.

The same procedure applies to File recovery and other operations with the backups.

4.3 Uninstalling Acronis vmProtect 6.0

To uninstall Acronis vmProtect Windows Agent, use the default Add or Remove Programs tool of Windows.

To uninstall Acronis vmProtect Virtual Appliance, you have to manually remove the VM with the virtual appliance from the ESX host with your VMware vSphere client.
5 Getting started

Once you installed the Acronis vmProtect or deployed your Acronis vmProtect Virtual Appliance, you can run the Acronis vmProtect Web Console. The Web Console will be opened in the default Internet browser.

Note that the Acronis vmProtect web server (installed on the Agent side) which provides the user interface uses self-signed certificates. As a result, you may receive the “There is a problem with this website’s security certificate” error message when connecting to Acronis Agent via your Internet Browser. To avoid this message, you should add this self-signed certificate to the list of trusted certificates. The exact instructions depend on the type of Internet browser you are using. You can refer to your browser’s help for further information.

Once the Web Console opens in the Internet browser, you will get a login screen where you need to provide user credentials for Acronis vmProtect. In case of Virtual Appliance-based installation, the default login:password is root:root. In case of Windows Agent-based installation, you should provide the credentials of any Windows user who has “Administrator” privileges on the machine with the Agent installed. The user should also be granted with “Log on locally”, “Access this computer from the network” and “Log on as a batch job” privileges. These privileges can be checked from Start-&gt;Run-&gt;secpol.msc-&gt;Security Settings-&gt;Local Policies-&gt;User Rights Assignment.
After logging in the Acronis vmProtect you will see a welcome screen with the Dashboard's Quick Start. The three buttons of this section will give you a hint of what to start with:

- First of all, to be able to perform the first backup task of a Virtual Machines, you have to go to the ESX Host section (p. 75) and specify the IP address / hostname and credentials for the vCenter or individual ESX host where these machines are running.
- Setting up an ESX host will not bind the licenses to it automatically. Therefore, you have to follow to the Licenses page (p. 71) to set up your licenses.
- After setting up your ESX hosts and licenses, you can run the New backup task wizard (p. 23), which will guide you through all the steps of the backup process.

5.1 Dashboard Management

After installing and running Acronis vmProtect (i.e. connecting to Acronis vmProtect component via web-based console), the default dashboard screen appears. Initially the dashboard contains 2 sections: the Quick Start section and the Virtual Machines section, which presents general information about your vCenters, ESX(i) hosts, the number of machines managed on the ESX(i) hosts and the number of mounted virtual machines. The Dashboard view will be changed from the initial (Quick Start) view after there is a backup task created. As a result of this change, the Quick Start section will disappear and the additional sections (described below) will be added.

The main workspace area of the Acronis vmProtect dashboard shows an overview of all currently running tasks or the last finished task details if there are no running tasks. The dashboard is designed to be the most user-friendly environment for presenting summary information about the current
status of your backup, restore and other tasks. It does so by using color-coding for successful and failed tasks. As the dashboard outlines all actions you can perform with Acronis vmProtect, it presents a very useful tool for a quick operational decision making.

You can switch to the dashboard by clicking the main Acronis vmProtect logo in the top left corner, or by clicking the Home button in the main menu. Any group on the dashboard, except Alerts, can be hidden into a tray with the respective minimize icon.

Tasks
The Tasks section presents summary information about the current tasks that are running or about the last completed task when there are no tasks running. The progress bar shows the completed percentage of the backup/restore tasks, task name, starting time, remaining time and current speed. From the dashboard Tasks block, you can directly open the task log, stop the task or switch to the View Tasks page.

Virtual Machines
The Virtual Machines section shows the hosts and clusters (vCenter) names and gives the total number of VMs running on the managed ESX(i) host(s) as well as the number of mounted virtual machines (see the Mounted VMs (p. 66) section).

Statistics
The Statistics section shows summary information about the backup/restore tasks executions. The information on a diagram is presented visually for quick and easy perception and analysis. The successful tasks are marked green. The failed tasks are marked red. The tasks finished with warnings are marked yellow. You can see the tasks percentages and get the detailed statistics for a certain date by pointing at the respective diagram. Also you can change the statistics view by clicking Hourly, Daily or Weekly.

Locations
The Locations section shows the total statistics for your backup locations status. It shows the Total backups number, information about the Occupied space, space Occupied by others, and Free space (both in megabytes/gigabytes and percentages). Occupied space is the space occupied by Acronis backups. Occupied by others is the space occupied by the data which is not a backup archive. The Free space statistics is available only for locations which support the retrieval of its value (for example there will be no such field for FTP locations). Also, from the Locations section you can switch directly to the Recovery Points view by clicking the link below.

5.2  Using Web Console

5.2.1  Ribbon tabs
The ribbon menu on the top of the screen allows for managing of the software and performing all of the operational functions. The basic Acronis vmProtect functions available through the top menu are described in the following sections below.
There are 3 main tabs in the Acronis vmProtect ribbon menu: **Actions** tab, **View** tab and **Configure** tab. The fourth additional Acronis tab appears dynamically depending on the current user-selected **View** or **Configure** operation.

**Dashboard view**

The **Home** button which always appears on the ribbon bar leads to the **Dashboard** view. The Dashboard configuration is described in the "Dashboard management" section (p. 18).

1) **Actions tab**

The first **Actions** tab contains the basic functions of Acronis vmProtect and allows for starting of the following basic tasks.

a. **Backup task**

This is the **Backup** button which runs the backup wizard. The backup wizard settings are described in the "Creating a backup of virtual machines" section (p. 23).

b. **Restore task**

This is the **Restore** button which runs the restore wizard. The restore wizard settings are described in the "Restoring a backup of virtual machines" section (p. 35).

c. **Run VM from backup task**

This is the **Run VM from Backup** task button which activates the run VM from backup wizard. The run VM from backup wizard settings are described in the "Running VM from backup" section (p. 47).

d. **Files recovery task**

This is the **File Recovery** button which runs the files recovery wizard. The files recovery wizard settings are described in the "File recovery" section (p. 43).

e. **Validation task**

This is the **Validate** button which starts the new validation task. The backup validation task is described in the "Validating backup" section (p. 64).

2) **View tab**

The second **View** tab contains the basic data views of Acronis vmProtect and allows quick navigation and switching between these basic views.

a. **Tasks view**

This is the link to the **Tasks** view. The Tasks management is described in the "Managing tasks" section (p. 52).

b. **Recovery points view**

This is the link to the **Recovery Points** view. The Recovery Points management is described in the "Managing recovery points" section (p. 57).
c. Mounted VMs view
This is the link to Mounted VMs view. The Mounted virtual machines management is described in the "Managing mounted VMs" section (p. 66).

d. Show logs view
This is the link to the Show logs view. The Logs management is described in the "Managing logs" section (p. 68).

3) Configure tab
The third Configure tab contains the basic tools for Acronis vmProtect configuration and allows you to specify the default settings for the basic backup/restore operations as well as other settings.

a. ESX hosts
This is the link to the ESX hosts management page. Managing ESX(i) hosts is described in the "Managing ESX hosts" section (p. 75).

b. Licenses
This is the link to the Licenses management page. Managing licenses is described in the "Managing licenses" section (p. 71).

c. Settings
Activate online backup subscription settings and Online backup proxy settings are available on the ribbon. For example, if your internet connection uses a proxy server, you can make all the necessary settings here.

Also there are two links to the Backup settings and Restore settings on the Configure tab. These backup/restore settings, as well as other settings, are described in detail in the "Managing settings" section (p. 79).

Click the Backup settings or Restore settings button to open the backup/restore settings page where you can set up the defaults for all the backup/restore tasks.

4) vmProtect dynamic tab
This is the dynamic tab which appears in the ribbon and changes depending on the currently selected action of the View or Configure tabs. This dynamic tab shows the buttons which are specific to the current View or Configure tab actions.

a. View -> Tasks
When the Tasks view is selected, the Tasks tab appears in the ribbon menu. The Tasks management page is described in the "Managing tasks" section (p. 52).

b. View -> Recovery Points
When the Recovery Points view is selected, the Recovery Points tab appears in the ribbon menu. The Recovery Points management page is described in the "Managing recovery points" section (p. 57).
c. View -> Mounted VMs
When the Mounted VMs view is selected, the Mounted VMs tab appears in the ribbon menu. The Mounted VMs page is described in the "Managing mounted VMs" section (p. 66).

d. View -> Show Logs
When the Show Logs view is selected, the Logs tab appears in the ribbon menu. The Logs management page is described in the "Managing logs" section (p. 68).

e. Configure -> Licenses
When Configure -> Licenses is selected, the Licenses tab appears in the ribbon menu. The Licenses management page is described in the "Managing licenses" section (p. 71).

f. Configure -> ESX(i) hosts
When Configure -> ESX(i) Hosts is selected, the Hosts tab appears in the ribbon menu. The ESX(i) Hosts management page is described in the "Managing ESX hosts" section (p. 75).

5.2.2 Logout link
In the top right corner of Acronis vmProtect you can see your current user name and the Logout button to exit the program or reenter it with another user name.
6 Creating a Backup of Virtual Machines

Click Create Backup Task in the dashboard’s Quick start or Backup in the Actions tab of the main menu to create a new backup task. The New Backup Task wizard opens in the main workspace area and asks you to provide the required information and make all necessary settings for the new create backup task. The wizard consists of the four consecutive steps which appear in the same area:

- What to backup.
- Where to backup.
- When to backup.
- How to backup.

These four steps of the wizard and their possible options are described below.

6.1 What to Back Up

In the first step, you should select the virtual machines (or vApps) which you want to back up. The left side shows all your ESX hosts/vCenters managed by Acronis vmProtect Agent with the list of their virtual machines. If you don’t see the exact virtual machine to back up that you are looking for in this list, make sure that you have added the corresponding ESX host from the Configure->ESX Hosts page.

Select the virtual machines (or vApps) by moving the machines from the left side of the butterfly control to the right one, via the “>” and “<” buttons. The list on the right shows all the virtual machines selected for backup. The “>” button is used to add the VM to the backup list, and the “<” button is used to remove the VM from this list.

You can back up dynamic groups of the machines by selecting the upper level unit (e.g. ESX host or VMs folder) in the tree and moving it to the right list with the same “>” button. As a result, all the machines running within this group will be automatically included in the backup list. Moreover, any new machines created in this group will be backed up automatically by the current backup task.

After you make the selection of “What to backup”, click Next to finish the first step and continue further on.

6.2 Where to Back Up

In the second step, you should define the location for your backup archive. Select a location by clicking on the Browse button. You will see a pop-up window with the browsing options where you can define or change the path and set the archive name. From the list of recent locations, you can either select one of the locations that was previously used or set up a new one.
The **Archive name** field shows the name of the archive selected in the **Browse** pop-up.

The left side of the **Browse** pop-up shows the list of:

- Online backup storages.
- Local folders.
- Network folders.
- FTP and SFTP servers.
- Recent Location.

Choose one of the backup location types from the browse tree on the left side. If the chosen location requires authentication (Online backup storage, Network folders or FTP/SFTP servers), you will initially see a dialogue box for submitting your credentials in the right pane. After successfully logging in, this pane shows the contents of the selected location, i.e. the archives inside this location.

Note that to successfully backup to an FTP/SFTP server, you need to have the deletion rights assigned to the respective file and folder on that server.

Instead of browsing for the location in the tree, you can manually enter the path in the corresponding **Location** field below and click on the **Go** button to explore this location. In this case, you will see the same authentication dialogue in the right pane where you are asked to enter your login and password.
Enter your archive name value in the corresponding *Archive name* field below. Note that it is not recommended to have more than one backup task writing data to the same archive. The retention rules applied to the archive by different backup tasks may cause an unpredictable outcome.

After you’ve selected “Where to backup”, click on **Next** to finish the second step and proceed to the third one.

### 6.3 When to Back Up

In the third step of Create backup task wizard, you should define the schedule of backing up your virtual machines data. There are two options available – scheduling your backup, and creating a single time backup task (“Do not schedule, run on demand”). The default value is “Do not schedule, run on demand”, which means that the backup task will be started either right after going through all the steps of the wizard or could be run later from the **Tasks** view.

Clear the **Do not schedule, run on demand** check box to set your scheduling of how often to back up the data. Acronis vmProtect allows for weekly scheduling and functions in Windows and Linux operating systems.

In the **Schedule** area, select the appropriate parameter as follows: Every: <...> week(s) on: <...>. Specify a certain number of weeks and the days of the week you want the task to be run. For
example, with the Every 2 week(s) on Mon setting, the task will be performed on Monday of every other week.

In the During the day execute the task... area, select one of the following: Once at: <...> or Every: <...> From: <...> Until: <...>.

For the Once at: <...> choice, set up the time at which the task will be run once.

For the Every: <...> From: <...> Until: <...> choice, set up how many times the task will be run during the specified time interval. For example, setting the task schedule to Every 1 hour From 10:00:00 AM until 10:00:00 PM allows the task to be run 12 times from 10 AM to 10 PM during one day.

Let’s see some of the scheduling examples.

"One day in the week" schedule

This is a widely used backup schedule. If we need to run the Backup task every Friday at 10 PM, the parameters are set up as follows:

1. Every: 1 week(s) on: Fri.
2. Once at: 10:00:00 PM.

"Workdays" schedule

Run the task every week on workdays: from Monday to Friday. During a workday, the task starts only once at 9 PM. The schedule’s parameters are thus set up as follows:

1. Every: 1 week(s) on: <Workdays>. Selecting the Workdays check box automatically selects the corresponding check boxes (Mon, Tue, Wed, Thu, and Fri), and leaves the remaining two unchanged.
2. Once at: 09:00:00 PM.

After setting up your backup schedule of “When to backup”, click Next to go to the last step of the wizard.

6.4 How to Back Up

On the fourth step you should define the preferences of your new backup task.

6.4.1 Backup type

First of all, you should define the archive type for the new backup. Acronis vmProtect can save your backup data by using one of the two basic types of archives – Standard archive (Legacy mode) or Always Incremental archive.

The archive type is selected by the Single file for all backups option. When this check box is cleared, each of your backups will be saved into a separate file. This is the Legacy archive (please, refer to "Multiple files backup scheme (Legacy mode)” section (p. 7)). When this check box is selected (recommended), all the backups will be physically saved into one file. This means that the archive will have the new enhanced “Always Incremental” format (please, refer to "Single file backup scheme (Always Incremental)” section (p. 8)).
In case of editing your existing backup task or selecting an existing archive for the backup location, this setting is not shown.

6.4.2 Retention rules

Next, you should define the retention rules for backup management inside the archive. The availability of the options depends on the schedule setup in the previous step (section “When to Backup” (p. 25)) and on the selected archive format (section “Backup type” (p. 26)). For example, the Grandfather-Father-Son (GFS) cleanup scheme will not be available for the unscheduled backup task. Create full backups every: <...> choice will not be available for the “Single file for all backups” option (as full backups don’t make sense for the Always Incremental archive format). What follows is a description of each retention rule.

1. Not specified

If the retention rules are not specified, then no programmed backups management will be performed, i.e. all the backups will be stored inside the archive indefinitely.

Create Backup wizard, Step 4 “How to backup”, retention rules are “Not specified”

2. Simple cleanup scheme

The selection of the simple cleanup scheme allows you to keep a certain number of backups inside the archive or keep the backups for a certain time period.
Create Backup wizard, Step 4 "How to backup", Simple cleanup scheme, delete the outdated backups

The second option allows you to clean up the archive if the number of backups exceeds <...>. Again, if you set this number at 1, then for the Always Incremental archive mode there will be a synthetic full backup created, i.e. an incremental backup which will remove the unnecessary old recovery point contents after the backup is finished. If the retention number of archives is greater than 1, then the cleanup is performed according to the Always Incremental archive mode (refer to section “Single file backup scheme (Always Incremental)” (p. 8) of this User Manual for further information).

3. GFS cleanup scheme

This is a common “Grandfather-Father-Son” cleanup scheme which allows you to keep a certain number of daily, weekly and monthly backups. Indicate how many daily, weekly and monthly backups you need to keep. All backups made within one day are considered to be “daily” ones and will be all deleted when that date is expired. The same rule applies to “weekly” backups.
Note that retention rules are applied only before the backup task execution. The reason for this is that with the Always Incremental archive there is no need to remove recovery points after the backup because it does not free disk space. If after performing the backup there are new excessive recovery points which have to be deleted according to the set up retention rules, they will be removed only before next backup. For example, if you set up the retention rules to delete the backups and the archives if your backups are older than 3 days or number of backups in the archive exceeds 3, there will actually be up to 4 backups stored in the archive, and not 3.

Note that at least one backup will always remain intact inside the archive even if this backup becomes subject to deletion according to the specified retention rules. This design ensures that you always have at least one backup available for recovery in the archive. This will be true until you clear the Never delete the last remaining backup check box (selected by default) which defines the behavior of the program when there is only one valid recovery point left and it becomes subject to deletion. This may be the case, for example, when you have applied a backup task to a group of virtual machines and one of the machines has been deleted from the ESX host, making it no longer possible to be backed up. At some point (according to the specified retention rules), all the backups of this deleted VM will become subject to deletion. Accordingly, the Never delete the last remaining backup check box will prevent or force the deletion of the last remaining backup.
6.4.3 Backup validation

If you would like to check the newly created backup for consistency (perform the backup validation), select the Validate after backup check box (for further information on Backup validation, please refer to section "Validating backups" (p. 64)).

6.4.4 Other settings

Click More options to open the pop-up with the additional settings. These options are described in the "Options" section (p. 30).

6.4.5 Completing the Create backup task wizard

To complete the New backup task wizard, you should define the task name. Note that [ ] { } ; , . symbols are not allowed for the task name.

When you click on the Save button, all the parameters of your set up backup task will be saved and you will see the created task in the Tasks view. Clicking on the Save & Run button will result in saving the task and running it right away.

6.5 Options

Clicking on the More options in the last step of the New Backup Task wizard opens up a pop-up with the settings. If no changes were made to the settings, they will retain their respective default values for your current backup task. Note that if later on you change certain settings and save them as default, it will not affect the tasks created with the default settings (they will retain the settings which were default at the moment of the task creation).

This section below describes all the settings one by one.

6.5.1 Archive Protection

The default value for the Archive protection parameter is “Disabled”. This option is not available when editing the existing task or when creating a new task specifying the existing archive.

In order to protect your archive from unauthorized access, select the Set password for the archive check box, then type your password in the Enter the password field; and, finally re-type it in the Confirm the password field. Note that the password is case-sensitive.

The created archive can be protected either with just a password or enhanced with the Advanced Encryption Standard (AES) 128/192/256-bit key encryption algorithm. If you select Do not encrypt, your archive will be protected with the password only. If you would like to use the encryption, select one of the following: AES 128, AES 192 or AES 256.

The AES cryptographic algorithm operates in the Cipher-block chaining (CBC) mode and uses a randomly generated key with a user-defined size of 128, 192 or 256 bits. The larger the key size, the longer it will take for the program to encrypt the archive and the more secure your data will be.
6.5.2 Source Files Exclusion

With the source files exclusion rules you can define which data will be skipped from the source data during the backup process and thus be excluded from the list of backed up items. These can be files or folders defined by a path set up for exclusion.

This option is effective for the backup of virtual machines which contain volumes of NTFS and FAT file systems only. Specifically, it works with all switched off VMs (with FAT and NTFS file systems) and for switched on VMs with OS version windows server 2003 and higher. Besides, the option requires VMware tools running on the target VM.

Use the following parameters to specify which files and folders to exclude.

Exclude files matching the following criteria

Select this check box to skip files and folders with names matching any of the listed criteria (called file masks). Use the Add, Edit, Remove and Remove All buttons to create and manage the list of file masks.

You can use one or more wildcard characters “*” and “?” in a file mask.

To exclude a folder specified by a path containing the drive letter, add a backslash (“\”) to the folder name in the criterion, for example: C:\Finance\. 

For example, you can set the Source files exclusion to Exclude files matching the following criteria: *.tmp, *.~, *.bak

6.5.3 Compression Level

The Compression level option defines the level of compression applied to the data being backed up. The default setting for this option is Normal.

The optimal data compression level depends on the type of data being backed up. For example, even maximum compression will not significantly reduce the archive size if it already contains fairly compressed files, such as .jpg, .pdf or .mp3. However, such formats as .doc or .xls could be significantly further compressed.

Select one of the following compression levels:

- **None.** The data will be copied “as is”, without any compression. The resulting backup size will be maximal.
- **Normal.** This compression level is recommended in most cases.
- **High.** The resulting backup size will typically be less than for the Normal level.
- **Maximum.** This is the highest degree of the data compression. But the time for performing backup task will be maximal. You may want to select maximum compression when backing up to removable media to reduce the number of required volumes.

6.5.4 Error Handling

These options enable you to specify how to handle errors that might occur during backup.
When a recoverable error occurs, the program re-attempts to perform the failed operation. You can set the time interval and the number of attempts. The task finishes as soon as the operation succeeds OR the specified number of attempts is reached.

If you select the Re-attempt, if an error occurs check box, set up the Number of attempts and the Interval between attempts. This option is enabled by default with the following settings: Number of attempts – 5, and Interval between attempts – 30 seconds.

For example, with the default settings if the backup destination on the network becomes unavailable or not accessible, the program will attempt to reach the destination every 30 seconds, but no more than 5 times. The attempts will be stopped as soon as the connection is resumed or if the specified number of attempts is reached.

6.5.5 Notifications

1) E-mail notifications

This option sets up e-mail notifications about the basic events during your backup task, such as successful completion, backup failure or need for user interaction. The default setting for this option is Disabled.

Select the Send e-mail notifications check box to enable notifications.

Under Send e-mail notifications check box select the desired settings as follows:

- **When backup completes successfully** – to send a notification when the backup task has completed successfully.
- **When backup fails** – to send a notification when the backup task has failed.
- **Add full log to the notification** – to receive the full log.

Type one or several e-mail addresses where notifications will be sent. Addresses are entered in the E-mail addresses field separated by semicolons.

Indicate the desired Subject for your notification messages.

**SMTP server** – enter the name of the outgoing mail SMTP server.

**Port** – set the port of the SMTP server (the default port value is set to 25).

**User name** – enter your username.

**Password** – enter your password.

**From** – type the e-mail address of the user from whom the message will be sent. If you leave this field empty, messages will be sent as if they are from the destination address;

**Use encryption** – you can opt for the encrypted connection to the mail server and choose SSL or TLS encryption types.

Click **Send test e-mail message** to make sure all your settings are correct.
2) SNMP notifications

This option defines whether the agent(s) operating on the managed machine have to send the logs of the backup operation events to the specified Simple Network Management Protocol (SNMP) managers. You can choose the types of events to be sent. The default setting for this option is: Disabled.

Select whether to send the backup operation events log messages to machines running SNMP management applications, please, choose one of the following:

- **Do not send SNMP notifications** – to disable sending the events log of the backup operations to SNMP managers.
- **Send SNMP notifications individually for backup operation events** – to send the events log of the backup operations to the specified SNMP managers.

**Type of events to send** – choose the types of events to be sent: Info, Warnings or Errors.

**Server name or its IP** – type the name or IP address of the host running the SNMP management application where the notifications will be sent to.

**Community** – type the name of the SNMP community to which both the host running the SNMP management application and the sending machine belong. The typical community is public.

Click **Send test message** to make sure all your settings are correct.

6.5.6 Additional Settings

1) Deduplication

This option defines whether to enable or disable the deduplication for the archive created by the backup task. The default setting for Deduplication is: Enabled.

Deduplication is performed on the archive level. This means that only the data which is saved to this archive will be deduplicated. In other words, if there are 2 archives saved into the same location with deduplication enabled, the duplicated data which may be present in both of these archives will not be deduplicated.

2) CBT backup

This option defines whether to utilize the Changed Block Tracking feature of VMWare for the virtual machines supporting it. The default setting for CBT backup is: Disabled.

CBT backup keeps track of all the changed blocks inside the virtual machine. This significantly reduces the time for creating backups. The time is reduced because Acronis vmProtect does not need to check which blocks have changed since the last backup. It gets this information from the VMWare API.

3) Use FTP in active mode

It is possible to use FTP active mode for FTP authentication and data transfer. The default setting for Use FTP in active mode is: Disabled.

Enable this option if your FTP server supports active mode and you want this mode to be used for file transfers.

After you finished with all the settings, click **OK** to close the pop-up and apply them for the current backup task only.
6.6 Managing created backup task

When editing an existing backup task you will see all the sections (steps) of the backup wizard you completed while creating your backup task. All four steps of the wizard will appear on the screen at once. Note that when editing an existing backup task you cannot modify the archive type (Always Incremental or Legacy Mode). (For further information, please, refer to “Managing Tasks” section (p. 52)).
7 Restoring a Backup of Virtual Machines

Click on the Restore button in the Actions tab of the main menu to restore one or several backed up virtual machines. The Restore Backup wizard opens in the main workspace area and asks you to provide the required information and configure the necessary settings for the new restore task. The wizard consists of the three consecutive steps which appear in the same area:

- What to restore.
- Where to restore.
- How to restore.

These three steps of the restore wizard and their possible options are described below.

7.1 What to restore

In the first step of the restore backup task wizard, you should define the backup location and select the virtual machines to be recovered. The chosen locations are scanned for the archives presence and contents, which is necessary to define the recovery point(s) for backup restore.

Click Browse to select the location and/or archive. In the pop-up window with the browsing options you can define the path and/or the archive name. Here, you can also see the locations which were used before.

There are two ways of selecting locations in the browsing window. First, you can select just a location. In this case you will see the whole tree-list (under the selected locations) of all the virtual machines and all their restore points in the selected location. Second, you can select both a location and an archive, in which case you will see just the contents of this archive.

Note that if you select an archive which contains an image of a physical machine (when you need to perform “physical to virtual” or P2V migration), there will be no other options provided at this step, because such archives have a single recovery point inside.

If the selected location contains any password-protected archives or archives of physical machines, then the VMs included in these archives cannot be shown, and you will be warned about it. In this case, in order to restore your data from these archives, you have to specify its name directly in the Browse pop-up.

You can select any of the virtual machines from the left side list and move them to the Selected Virtual Machines section on the right. The selection of the virtual machines is done by moving the machines from the left side of the butterfly control to the right one, via the “>” and “<” buttons. The list on the right shows all the virtual machines selected for recovery. The “>” button is used to add the VM to the recovery list, and the “<” button is used to remove the VM from this list. This list contains the selected virtual machines and their latest available recovery point(s), i.e. point(s) in time you can go back to.

For each virtual machine the latest recovery point is selected by default. This recovery point could be changed by clicking on it. The pop-up window will appear where you can select a different recovery point.
In the Select Recovery Point pop-up you can see the list of all recovery points available for this virtual machine and select the recovery point to be restored. The list includes the name of the archive which includes this recovery point and its creation time.

After you selected “What to restore”, click **Next** to finish the first step of the wizard and continue further on.

### 7.2 Where to restore

In the second step of the restore backup task wizard, you should define where to restore the selected virtual machine(s) to.

First of all, with the **Select location** drop-down list you should define the desired destination for your restore task. Please choose if you want to restore the selected virtual machine(s) to their original location or to a different ESX host or datastore. The list shows only those ESX hosts which are managed by Acronis vmProtect Agent. If the ESX host you need is not in this list, then make sure it is added in the **Configure -> ESX hosts** view.

Note that when restoring to “Original Location” the restored VM may not appear in the same location as it was at the moment of creating the recovery point. This will be the case if the selected VM (defined by the recovery point) has been migrated to a host and/or datastore, ESX host, resource pool or vApp. Since VMs are preserving their UUIDs during migration, the recovery will go to the
current location of the virtual machine. For example, at the moment of creating the recovery point the VM was in vApp1, but later it has migrated to vApp2. Then this VM will be restored to vApp2 overwriting the existing VM.

Once the ESX host is defined, the list of available resource pools and datastores is build up automatically where you can define the exact location for the restored virtual machine(s).

You should also define the format of the restored virtual drives, “As in original VM (recommended)”, “Thin provisioning” or “Thick provisioning” with the respective drop-down list. Thin provisioning increases the VM storage utilization by enabling dynamic allocation and intelligent provisioning of the physical storage capacity.

Based on this selection, a hint will appear indicating how much space is required on the datastore for the successful recovery operation. You cannot proceed to the next step of the restore backup task wizard until the valid datastore with enough free space is selected.

Note that when restoring multiple virtual machines all of them will be placed to the destination defined at this step of the restore wizard, each to unique new VM on the selected datastore.

If there are virtual machines on the selected ESX host or datastore with the same names, you will be asked to confirm overwriting the existing VMs. This choice defines the restored virtual machines naming. If you choose to “Overwrite VMs”, then the existing virtual machines will be replaced with the restored ones.
Note that in this case the datastore selection will be unavailable (since it is already defined by the target VM being overwritten), however, you can change the resource pool location for this VM by choosing corresponding item in the Resource Pool selection.

Note that if the existing machines are running, then for the successful recovery operation you should either stop them manually or select the Power off target VMs when starting recovery option in the recovery options dialogue (see "VM power management" section (p. 41)).

When choosing the Create VMs with different names option the restored VMs will be named according to the following convention:

“[Original_VM_name]_DATE”.

Where “Original_VM_name” is the initial name of the restored virtual machine, and DATE is the current date. For example if the restored VM was called “VM_original” then after recovery it will be named “VM_original_05/25/2011”.

After you completed the selection of “Where to restore”, click Next to finish the second step and proceed to the last one.

7.3 How to restore

In the third step of the restore backup task wizard, you should define the preferences of your recovery task.

Here you can specify whether to validate the archives before the recovery (for further information on Backup validation, please refer to “Validating backups” section (p. 64)). Also, here you can adjust the settings for your recovery task by clicking the More options... link.
To complete the wizard and create the restore backup task you must set up the task name and define how to run it. Note that [ ] { } ; . symbols are not allowed for the task name.

When you click on Run Now button the task will be immediately executed with the specified parameters. You could see the task progress bar in the Tasks view and in the Dashboard view. This is your choice if you want to execute this task just once. The result of this task will be shown in the Dashboard or can be checked through the Logs view.

Clicking the Save button results in saving the task in the tasks list (View->Tasks). This is more convenient if you plan to run this task manually later from the Tasks view page or run this task several times.

### 7.4 Options

Click More options... on the last step of the restore backup task wizard to open the pop-up with the additional settings.

In case of no changes made to the settings, they will retain their respective default values for your current restore task. Note that if later on you change certain settings and save them as default, it will not affect the tasks created with the default settings (these settings will retain the values which were default at the moment of the task creation).
### 7.4.1 Notifications

**1) E-mail notifications**

This option allows setting up the e-mail notifications about the basic events during your restore task, such as successful completion, restore failure or need for user interaction. The default setting for this option is disabled.

Select the Send e-mail notifications check box to enable notifications.

Under Send e-mail notifications check box select the desired settings as follows:

- **When recovery completes successfully** – to send a notification when the restore task has completed successfully.
- **When recovery fails** – to send a notification when the restore task has failed.
- **Add full log to the notification** – to receive the full log.

Type one or several e-mail addresses where notifications will be sent. Addresses are entered in the E-mail addresses field separated by semicolons.

Indicate the desired Subject for your notification messages.

- **SMTP server** – enter the name of the outgoing mail SMTP server.
- **Port** – set the port of the SMTP server (the default port value is set to 25).
- **User name** – enter your username.
- **Password** – enter your password.
- **From** – type the e-mail address of the user from whom the message will be sent. If you leave this field empty, messages will be sent as if they are from the destination address;

**Use encryption** – you can opt for the encrypted connection to the mail server and choose SSL or TLS encryption types.

Click Send test e-mail message to make sure all your settings are correct.

**2) SNMP notifications**

This option defines whether the agent(s) operating on the managed machine have to send the logs of the restore operation events to the specified Simple Network Management Protocol (SNMP) managers. You can choose the types of events to be sent. The default setting for this option is disabled.

Select whether to send the restore operation events log messages to machines running SNMP management applications. Please choose one of the following:

- **Send SNMP notifications individually for restore operation events** – to send the events log of the restore operations to the specified SNMP managers.
  **Types of events to send** – choose the types of events to be sent: Info, Warnings or Errors.
  **Server name or it's IP** – type the name or IP address of the host running the SNMP management application the notifications will be sent to.
Community – type the name of the SNMP community to which both the host running the SNMP management application and the sending machine belong. The typical community is "public"; Click Send test message to make sure all your settings are correct.

- Do not send SNMP notifications – to disable sending the events log of the restore operations to SNMP managers.

7.4.2 Error Handling

These options enable you to specify how to handle errors that might occur during the restore operation. Select the Re-attempt, if an error occurs check box for enabling the silent mode.

When a recoverable error occurs, the program re-attempts to perform the failed operation. You can set the Interval between attempts and the Number of attempts. The task finishes as soon as the restore operation succeeds OR the specified number of attempts is reached.

If you select the Re-attempt, if an error occurs check box, set up the Number of attempts and the Interval between attempts. This option is enabled by default with the following settings: Number of attempts – 5, and Interval between attempts – 30 seconds. For example, if the restore network destination becomes unavailable or not accessible, the program will attempt to reach the destination every 30 seconds, but no more than 5 times. The attempts will be stopped as soon as the connection is resumed or if the specified number of attempts is reached.

7.4.3 VM power management

These options allow configuring the virtual machines power management before and after executing the restore backup task.

1) Power off target VMs when starting recovery

Recovery to an existing virtual machine is not possible if the machine is online, and so the machine is powered off automatically as soon as the recovery task starts. All users will be disconnected from the machine and any unsaved data will be lost.

This option is enabled by default. Clear the Power off target VMs when starting recovery check box if you prefer to power off virtual machines manually before the recovery task.

2) Power on target VMs when recovery is finished

After a machine is recovered from a backup to another machine, there is a chance that the existing machine’s replica will appear on the network. For a safe operation, power on the recovered virtual machine manually, after you take the necessary precautions.

This option is disabled by default. Select the Power On target VMs when recovery is finished check box for starting up the virtual machine automatically.
7.4.4 Additional Settings

Use FTP in active mode

It is possible to use FTP active mode for FTP authentication and data transfer. The default setting for Use FTP in active mode is disabled.

Enable this option if your FTP server supports active mode and you want this mode to be used for file transfers.

After you finished with all the settings, click OK to close the pop-up and apply them for the current restore task only.

7.5 Managing created restore task

When editing an existing restore task you will see all the sections (steps) of the wizard you completed while creating you restore task. All three steps of the wizard will appear on the screen at once. (For further information, please refer to “Managing Tasks” section (p. 52)).
# 8 File Recovery

Sometimes there is a need to recover just a single file or just a few files from a backup archive without restoring the whole virtual machine. The **File Recovery** feature allows browsing the archive and restoring the selected files for the pre-defined version of this archive (recovery point). The recovery destination is defined by the available options provided by the Internet browser which runs the vmProtect Management Console (the dialogue is the same as you see when trying to save some Internet page via **File->Save As...** option).

Click **File Recovery** in the **Home** tab of the main menu to restore one or several backed up files. The **File Recovery** wizard opens in the main workspace area and asks you to provide the required information and configure the necessary settings for the file recovery task. The wizard consists of the two steps:

- What to recover.
- Explore recovery point.

## 8.1 What to Recover

First, you should define your backup location which will be then scanned for archives and their contents.

Click **Browse** to select the location and/or archive. In the pop-up window with the browsing options you can define the path and/or the archive name. Here you can also see the locations which were used before under **Recent Locations** item.
There are two ways of selecting locations in the browsing window. First, you can select just a location. In this case, you will see the whole tree-list (under the selected locations) of all the virtual machines and all their archives stored in the selected location. Second, you can select both a location and an archive, in which case you will see just the contents of this archive.

If the selected location contains any password-protected archives or archives of physical machines, then the VMs included in these archives cannot be shown, and you will get a warning. In this case, in order to restore your data from these archives, you have to specify its name directly in the Browse pop-up.

The selected location is scanned for archives and their contents. As a result of the scan, on the left side you will see a tree-list of the virtual machines included in all archives stored in the selected location or inside the selected archive. By clicking on any virtual machine, you can check the list of all its recovery points on the right side.

For each machine, the latest recovery point is selected by default. The recovery point could be changed by clicking on it. Note that File Recovery allows the selection of just a single Virtual Machine and single recovery point at a time, while the Restore Backup task allows recovery of several VMs.

After selecting the recovery point for the virtual machine you can proceed to the next step. This recovery point defines the virtual machine state which you want to extract files or folders from.
8.2 Explore Recovery Point

In the second step of the File Recovery wizard you have to choose which files or folders to restore. Here you can see the selected VM recovery point contents with a Windows Explorer-like directory browser. In the browsing tree on the left side you can expand the volumes and folders and browse/select the contents of each volume/folder you want to recover on the right side.

Acronis vmProtect File Recovery wizard has the built-in search feature. The search box is located in the top right corner above the files and folders list. You can use the search when you don’t know the exact file name you want to restore. You can filter files and folders in the list, and see only those that match any of the search criteria called “file masks”.

You can use one or more wildcard characters “**” and “?” as a file mask.

To exclude a folder specified by a path containing the drive letter, add a backslash (“\”) to the folder name in the mask, for example: C:\Finance\.

Also, you can sort the search results by any of the columns: name, date and time modified, size, and folder. If you select to sort first by a certain field, for example, by time, you can then select to sort by another field, for example, by name. In this case your data will have a sorting of 2 levels, first the name, and then the time. So you can easily find the needed files for recovery.

After you’ve selected all the files you would like to recover, click the Download button. You will see the default browser pop-up window (as for the right mouse click -> Save target as... pop-up) where
you can select the destination for saving the selected backup files. All files and folders you selected will be downloaded there as a single .zip archive.
9  Running VM from Backup

Click Run VM from Backup in the Home tab of the main menu to mount certain backed up virtual machine without restoring it. The Run VM from Backup wizard opens in the main workspace area and asks you to provide the required information and configure the necessary settings for the Run VM from Backup task. The wizard consists of the three steps:

- What VM to run.
- Where to run the VM.
- Additional settings.

These three steps of the Run VM from Backup wizard and their options are described below.

9.1  What VM to Run

In the first step of the Run VM from Backup wizard, you should first define the backup location and make a selection of the virtual machines to be run. The chosen locations are scanned for archives and their contents. This is necessary to pick up the recovery point(s) which will define the state of the virtual machine you want to run from backup. Running VM from backup process is also referred to as “mounting a virtual machine”.

Run VM from Backup wizard, Step 1 “What VM to run”
Click **Browse** to select the location and/or archive. In the pop-up window with the browsing options, you can define the path and/or the archive name. Here you can also see the locations which were used before under **Recent Locations** item. Note that for Run Vm from Backup locations, you can only select **Network folders** or **Local folders**. Other locations, such as **Online backup storage** or **FTP/sFTP servers**, are not available here.

There are two ways of selecting locations in the browsing window. First, you can select just a location. In this case you will see the whole tree-list (under the selected locations) of all the virtual machines and all their archives stored in the selected location. Second, you can select both a location and an archive, in which case you will see just the contents of this archive.

If the selected location contains any password-protected archives or archives of physical machines, then the VMs included in these archives cannot be shown, and you will be warned about it. In this case, in order to restore your data from these archives, you have to specify its name directly in the Browse pop-up.

You can select any of the virtual machines from the left side list and move them to the **Selected Virtual Machines** section on the right. The selection of the virtual machines is done by moving the machines from the left side of the butterfly control to the right one, via the “>” and “<” buttons. The list on the right shows all the virtual machines selected for mounting. The “>” button is used to add the VM to this list, and the “<” button is used to remove the VM from the list. This list contains the selected virtual machines and their latest available recovery points, i.e. points in time you can go back to.

For each virtual machine the latest recovery point is selected by default. This recovery point could be changed by clicking on it. The pop-up window will appear where you can select a different recovery point.

In the **Select Recovery Point** pop-up you can see the list of all recovery points available for this virtual machine and select the recovery point to be mounted. The list includes the timestamps of the recovery points, the file name of the archive which includes this recovery point and its size.

After you selected “What VM to run”, click **Next** to finish the first step of the wizard and continue further on.

### 9.2 Where to Run the VM

In the second step you should define where to run the selected virtual machine(s).
First of all, with the Select Location drop-down list you should define the ESX host where you want to mount the selected VMs on. The list shows only those ESX hosts which are managed by Acronis vmProtect Agent. If the ESX host you need is not in this list, then make sure it is added in the Configure → ESX hosts view.

Once the ESX host is defined, the list of available resource pools is build up automatically where you can define the exact location for the mounted virtual machine(s). The datastore selection is necessary to define where to store the changes made to the mounted virtual machine(s). As an alternative method (not recommended), you can choose to store the changes on the NFS storage provided by Acronis vmProtect Agent itself.

Note that when mounting multiple virtual machines all of them will be placed to the destination defined at this step of the Run VM from backup wizard, each to one particular resource pool. The changes made to these VMs will be saved to unique folder on the selected datastore or NFS storage.

If you don’t have an available datastore to keep the changes on, or if you cannot define the datastore by picking it up from the list, you can optionally choose to mount the VM on local NFS storage (not recommended) provided by Acronis vmProtect Agent.

Also, note that Acronis vmProtect Agent is compatible with vMotion (Storage vMotion in particular). When the mounted VM is moved to another datastore via Storage vMotion, then upon unmounting it will remain in its new location. In this case the mounting process will be similar to backup restore since during vMotion all data is physically moved to the new datastore.
Please, specify the postfix for the mounted virtual machine name in the **Mounted VM name postfix** field. This is necessary since running two virtual machines with the same name on one ESX host is not possible, especially when there is the original VM already running on it. The mounted VM will be named using the following convention:

“[Original_VM_name]_mount”.

Where “Original_VM_name” is the original name of the mounted virtual machine and “_mount” is the postfix you can change. For example, if the mounted VM had the “VM_original” name then after mounting it will be named “VM_original_mount”.

After you completed the selection of “Where to Run the VM”, click **Next** to finish the second step and proceed to the last one.

### 9.3 Additional Settings

In the third step of the wizard you can select the check boxes for the **Power on the mounted VM** and **Connect to network** options.

Select the **Power on the mounted VM** option to automatically run your machine upon completion of the wizard. Note that the mounted machine's replica (e.g. the original machine) might appear on the
network. Therefore, for safe operation, it’s advisable to power on the mounted virtual machine manually after taking the necessary precautions.

Select the **Connect to network** check box when mounting a failed VM which is no longer present in the network. If you are mounting a VM for testing purposes (to ensure some data consistency inside) while the original VM is currently running, keep this check box cleared. Before you power on a VM, you should manually change the VM network configuration settings to disconnect it from the production network and re-connect to an isolated non-production network to avoid possible conflicts.

After clicking on the **Run Now** button, the selected VM will appear in VMWare Infrastructure Client and you will be able to manage it like any other virtual machine in your environment. In order to dismount (stop running) the VM you should go to the **View->Mounted VMs** view.

### 9.4 Managing created “Run VM from Backup” activity

There is no way to edit the existing **Run VM from Backup** activity. You can only unmount the mounted VMs from the **View->Mounted VMs** page.
10 Managing Tasks

Click Tasks in the View tab of the main menu to open the Tasks page (View->Tasks), where you can see the details and perform the operations with your tasks. Note that the Tasks page allows performing the basic operations with the existing tasks only, and doesn’t let you create new tasks (for creating a new Backup/Restore/Validation task you have to go to the Home tab of the main tool bar).

The Tasks page consists of the two main sections: the Tasks list and Task details.

The Tasks list is the general list of all the tasks created in Acronis vmProtect Agent. The tasks list contains the Backup, Restore and Validate operations which were created at the respective sections of the Home tab in the main tool bar.

The task list is presented with the following columns:

- **Name** – the unique task identifier.
- **Type** – Backup, Restore or Validation.
- **State & Progress** – Idle or In Progress.
- **Last finish time** – the time passed since this task finished last.

Tasks that are currently stopped appear as “idle” ones. If the task is currently running, then the State & Progress field shows the progress of the current activity in percentage (e.g. 35%).

Moreover, all the tasks which have already been executed have the last result status – Success, Warning or Error. This status is shown in the form of the icon – green for successful last operation, yellow – for the tasks with warnings at the last run, and red – for the task that ended in failure last time. Those tasks which were not run yet don’t have this status, and have the Last finish time field empty.

You can sort the tasks list by clicking the column header. For switching between the ascending and descending sort order click the column header one more time.

On the Tasks management page you can Run, Cancel, Edit, Delete or Show log for any of the tasks in the list by using the respective buttons in the ribbon bar (please, see subsections below). These operation buttons are enabled only when selecting a task in the list.

Also, you can check the Task details for any of the tasks by clicking it in the list. The details of the selected task appear in the right section where you can switch between the tabs to see the information about this task (please, see “Viewing task details” section (p. 53))

10.1 Running a task

You can run the selected idle task by clicking the Run button in the top ribbon menu. Upon running, the status of the task will be changed from “Idle” to the progress bar.
Note that you can only view task logs (see “Viewing task logs” section (p. 53)) and Cancel (see “Stopping a task” section (p. 53)) in the active running task. Other control buttons – Run, Edit and Delete – are disabled. In order to edit or delete the active task, you have to stop it first.

10.2 Cancelling a task
You can cancel the selected active task by clicking the Cancel button in the top ribbon menu. You’ll be asked to confirm the operation. Upon confirmation the progressing task will be immediately stopped and will go into the idle state.

The Cancel button for the idle task is disabled, as you can only cancel the task that is currently running.

10.3 Editing a task
You can edit the selected task by clicking the Edit button in the top ribbon menu. Depending on the task type, you will go to the respective section of the Actions tab – create backup, restore backup or validate backup. There, you will see all the sections of the backup/restore/validation wizard which you completed while creating that task. All the steps of the wizard will appear on the screen at once, where you can see the current task settings and can change any of these settings. (For further information, please, refer to sections “Creating a backup of virtual machines” (p. 23), “Restoring a backup of virtual machines” (p. 35) and “Validating backups” (p. 64)).

10.4 Deleting a task
You can delete the selected task by clicking the Delete button in the top ribbon menu. You’ll be asked to confirm the operation. Upon the delete task confirmation, it will be immediately erased.

10.5 Viewing task logs
You can see the selected task logs by clicking the Show Logs button in the top ribbon menu. You will go to the Logs view (View->Show Logs) section, where you can see all the logs for the current task (Please, see “Managing Logs” sections (p. 68)).

10.6 Viewing task details
Upon selecting any task in the task list, you can view its details in the right section. The information about the currently selected task is presented with a tab view. There are four tabs – Summary, Source, Target and Options (the default tab is Summary). Note that the tabs could present the
varying information depending on the task type – backup, restore or validation. The sections below describe the tabs contents for the backup task.

10.6.1 Summary tab

The Summary tab gives overview details of the current selected task. Here is an example of the possible contents of the Summary tab for the backup task:

**Start Time**: 12:00 03/04/2011  
**Remaining time**: 30 min  
**Last Finish Time**: N/A  
**Last Result**: N/A  
**Bytes transmitted**: 150Mb  
**Speed**: 20Mb/sec  
**Schedule**: Start the task every 1 hour on Monday, Tuesday
10.6.2 Source tab

The Source tab presents the tree of ESX hosts+vApps/VMs included into the backup task. The tree is build up dynamically. If there was an entire ESX host selected for backup, then this tree will be shown for the current state of the machines (the same list) same as in VMware IC. To the right of the ESX host there should be a mark that the entire group is being backed up ("All virtual machines" mark).

Here is an example of the possible values for the Source tab contents:

ESX Host 1 “All Virtual Machines”:
Small_vm

ESX Host 2:
AcronisESXAppliance (10.250.40.30)

10.6.3 Target tab

The Target tab presents the information on the location of the backed up archive. Here is an example of the possible values for the Target tab contents:

Location: \\NAS1\Backups\AcronisESX_Appliance_1557\azz11006756454cv\nArchive: Archive_name
Retention rules: Delete Backups older than 30 days / Keep only last 30 backups
10.6.4 Options tab

The **Options** tab shows the settings of the current selected task. This tab shows only the options which differ from default ones. If all task options are default, then this tab just states “Default options” without listing any specific values. Here is an example of the possible contents of the **Options** tab:

- **Compression level**: Maximum
- **Reattempt if an error occurs**: Off
- **Validate after backup**: On
- **E-mail notifications**: On
- **Type of events to send**: Errors
11 Managing Recovery Points

Click the **Recovery Points** button in the **View** tab of the main menu to open the **Recovery Points** page.

The **Recovery Points** view of Acronis vmProtect provides you with an interface to manage the recovery points available for the virtual machines in your environment or the points in time which you can go back to for each virtual machine. Upon the successful execution of each backup task, a new recovery point is created and the recovery points list is updated automatically.

After selecting the recovery point, you can perform basic operations with it. Operations on the selected recovery point can be executed by clicking the corresponding button on the main tool bar. All these operations, as described below, are wizard-driven and provide you with a simple way to accomplish the desired task.

The **Recovery Points** view contains 3 main sections:

- the Backup locations.
- the Virtual Machines catalog.
- the Recovery Points list.

The main idea for navigating this page is that you should first define the backup location (in the left section) which will then be scanned for the archives and their contents. The scan will show you a tree-list (in the middle section) of the virtual machines included in all archives stored in the selected location. When clicking on any virtual machine in this middle section you can check the list of available recovery points and summary details for this machine. This list is located in the section on the right.

The **Locations** list on the left side shows the registered backup locations (any location that has ever been used as backup target or recovery source). The **Locations** list includes the following elements, each location in a separate bloc:

- **Location** path, e.g. `\NAS1\Backups\Acronis\Recent`
- **Location** statistics:
  - **Backups size**, e.g. 3.242 Gb (22%).
  - **Used space**, e.g. 5.242 Gb (36%).
  - **Free Space**, e.g. 9.412 Gb (64%).
  - **Total Space** (**Used space** + **Free space**), e.g. 14.654 Gb.
- **Total backups** (i.e. total number of recovery points in the location).
- **Edit Credentials** button which allows to change the access credentials to the location (if applicable).
- **Remove Location** button which removes the location from the list of registered locations.

While there are no locations added, the widget will show empty field with the following text: “There are no registered backup locations.” The other 2 sections will not be shown up at all.
11.1 Adding a backup location

Optionally, you can add or remove the backup locations right from the Locations list. Click the Add New button on the top to open the Add Location pop-up.

Note that the remove operation will not physically remove the archives from the location, but will just delete the location from the Acronis vmProtect configuration. All the backups will remain intact inside the location and you can see them when you add it back via the Add button. Removing and adding locations may be required if you have some unnecessary backup locations which are no longer actual and you don’t want to see them anymore.

The left side of the Add Location pop-up shows the list of:
- Online backup storages.
- Local folders.
- Network folders.
- FTP servers.
- SFTP servers.
You can select the desired location by expanding the appropriate folder group and choosing it in the folder tree or by entering the full path to the location in the Location field.

Choose one of the backup location types from the browse tree on the left side. If the selected location (Online backup storage, Network folders or FTP/SFTP servers) requires an authentication, you will first see the dialogue for submitting your credentials in the right pane. After successfully logging in, this pane shows the contents of the selected location, i.e. the archives inside this location.

An alternative to browsing the location in the tree is entering the path in the corresponding Location field below and clicking the Go button to explore this location. In this case, you will also see the same authentication dialogue in the right pane where you are asked to enter your login and password.

You have to select or specify the path in the Location field in order to complete the wizard, and then click OK. The OK button is grayed out until there is a valid location selected.

### 11.2 Virtual Machines catalog

The middle section of the Recovery Points view presents the Virtual Machines catalog. This tree list of virtual machines and vApps is built based on parsing through the archives found in the location selected in the left section.

The virtual machines list in the middle section will be accompanied with the following warning in case the current location contains password-protected archives or archives of physical machines:

**Warning:** The selected location contains password-protected archives or archives of physical machines. The virtual machines list does not include the contents of such archives.
Managing recovery points, password-protected location

Only one virtual machine can be selected in this list at a time. The details window (the right section) for the selected virtual machine contains 2 tabs as explained below – the Recovery Points list and the Recovery Points details.

11.3 Recovery Points list

The Recovery Points list in the details section presents the list of all available recovery points which includes the following columns:

- **Recovery Points**: the column shows the date and time values corresponding to creation of each recovery point in the list.
- **Archive Name**: shows the file name (in the selected backup location) this recovery point belongs to.
- **Size**: shows the physical size of the archive (in Mb/Gb) this recovery point belongs to.

From the Recovery Points list you can switch to the Summary view (see "Summary tab" section (p. 61)).

After selecting a certain recovery point in the list you can perform any of the operations described in the "Operations on selected items" section (p. 61).
11.4 Summary tab

You can see the summary information on the selected recovery point by switching to the Summary tab. This tab shows the following information:

- **VM Comments** (taken from VMWare vSphere client Summary tab for the selected VM).
- **Guest OS** (taken from VMWare vSphere client Summary tab for the selected VM).
- **VM version** (taken from VMWare vSphere client Summary tab for the selected VM).
- **Provisioned Storage** (taken from VMWare vSphere client Summary tab for the selected VM).
- **Used Storage** (taken from VMWare vSphere client Summary tab for the selected VM).
- **Total number/size of recovery points**, for example 23 points/120Gb.

11.5 Operations on selected items

The Recovery Points view has the following operating buttons in the ribbon menu, which allow performing the basic operations with the selected recovery point:

- **Restore**.
- **Run VM from backup**.
- **File Recovery** (Guest Files download).
- **Validate**.
- **Delete**.

These operations are enabled when selecting a certain recovery point in the list (in the details section for the selected virtual machine as described in the "Recovery points list" section (p. 60)).

11.5.1 Restore

Click the Restore button in the ribbon menu to perform recovery from the selected recovery point by running the restore task wizard. The wizard will be pre-filled with the selected recovery point settings described in the "Restoring a backup of virtual machines" section (p. 35).

11.5.2 Run VM from backup

Click the Run VM from backup button in the ribbon menu to perform the Mounting VM operation by activating the Run VM from backup wizard. The wizard will be pre-filled with the selected recovery point settings described in the "Running VM from backup" section (p. 47).
11.5.3 File recovery

Click the File recovery button in the ribbon menu to perform the Guest File Download operation by running the File Recovery wizard. The wizard will be pre-filled with the selected recovery point settings described in the "File recovery" section (p. 43).

11.5.4 Validate

Click the Validation button in the ribbon menu to perform the Backup Validation by running the new validation task. The validation wizard will be pre-filled with the selected recovery point settings described in the "Validating backups" section (p. 64).

11.5.5 Delete

Click the Delete button in the ribbon menu to remove the selected recovery point. The Delete Recovery Point(s) pop-up will appear where you can see the list of recovery points selected for deletion.
Note, that in a Legacy Mode archive (p. 7) some recovery points may have dependencies. This means that deleting a single recovery point is impossible. In this case, the entire chain of recovery points which depend on the selected one will be designated for deletion. The recovery points which belong to the Always Incremental archive (p. 8) can be deleted without any constraints and you will see the single recovery point in the deletion list.

After confirming the operation by clicking the **Delete** button in the pop-up, the deletion task will appear in the **Tasks** view. This task will disappear upon completion. The result can be seen in the **Dashboard** view and in the log file.
12 Other Operations

12.1 Validating backups (Actions -> Validate)

Validating backups is an operation that checks the possibility of data recovery from a backup. Note that while successful validation means high probability of successful recovery, it does not check all factors that influence the recovery process. If you back up the operating system, only a test recovery to a new virtual machine can guarantee success of the recovery.

In Acronis vmProtect you can validate a Location, an Archive or a Recovery Point. Validation of a recovery point imitates recovery of all files from the backup to a dummy destination. Validation of an archive will validate all recovery points stored in this archive. Validation of a location will check the recovery of all archives stored in this location.

12.1.1 What to validate

First of all, you should define which item type you want to validate from 3 available options: Location, Archive or Recovery Point.

Location – Validating a location will check the integrity of all the archives inside this location. Note that this is usually a more time-consuming process than granular validation of specific archives or recovery points (especially if you store multiple archives in the location). The validation time also depends on the number of the backups (recovery points) included in each archive in the selected location. Note that password-protected archives will not be validated in this case. You should choose the option to validate Archive instead.
Validate backup task. What to validate. Location.

**Archive** – Validating an archive will check the integrity of all backups (recovery points) inside the specified archive. In general, this procedure will be faster than validating the whole location. However, it is slower than validating a specific recovery point inside this archive.

**Recovery Point** – To ensure that you can revert back to some specific recovery point, you can perform granular validation of just the selected recovery points (they don’t have to reside within one archive).

After selecting the validation item type, define the backup location. You can either specify a location or location and an archive in order to retrieve the list of recovery points. If you are validating a recovery point, the selected archive or location will be scanned for recovery points included there. This is needed in order to pick up the recovery point(s) to be validated. Depending on the selected validation item type, some controls will be disabled (for example, you will not see the list of recovery points if you validate a location or archive).

You can select the location and/or archive by clicking on the Browse button. You will see a pop-up window with the browsing options where you can define the path and/or the archive name.

As the result of the scan, you will see a tree-list (under the locations selection drop-down list) of the virtual machines included in all archives stored in the selected location (or inside the archive, if you specified the archive directly). You can select any of these virtual machines and move them to the Selected Virtual Machines section.
In the Selected Virtual Machines section you can see a list of the selected virtual machines with their available recovery points, i.e. point in time which contains a particular machine state. The recovery point can be selected by clicking on it.

To complete the validation task creation wizard, you must set the task name. Note that [ ] { } ; , . symbols are not allowed for the task name.

After clicking on the Run Now button, the selected items will be validated and you will see the progress of your newly created validation task in the Tasks view. You will see its result in the Dashboard view and in the Show Logs view.

12.2 Managing mounted VMs (View -> Mounted VMs)

Click Mounted VMs in the View tab of the Acronis vmProtect main ribbon menu to open the Mounted VMs page.
12.2.1 Mounted VMs list

The Mounted VMs view provides an overview on the virtual machines which are currently mounted or running from backup on an ESX host.

At first, when you don’t have any virtual machines running, the Mounted VMs list is empty. After you performed Run VM from backup operation (see “Running VM from backup” section (p. 47)), this Mounted VMs view will automatically open where you could see the machine you’ve just run.

In the table, you can see the list of these machines and their state: “Running” (if the machine is running) or “Stopped” (if not).

12.2.2 Mounted VMs details

You can check the details for any of the mounted virtual machines by selecting it from the list. The details of the selected virtual machine will appear in the right section where you can switch between the tabs to check the additional details.

Upon selecting any virtual machine in the list, you can view its details in the right section. The information about the currently selected task is presented with a tab view. There are three tabs – Summary, Source and Target (the default tab is Summary).
The first **Summary** tab presents overview details of the currently selected virtual machine. Here is an example of the possible contents of the **Summary** tab:

**Start Time/Date:** 20:11 11/05/2011

The **Source** tab presents the tree of mounted ESX hosts+vApps/VMs. Here is an example of the **Source** tab contents:

**Location:** `\\Backups\\
**Archive:** Archive_name

ESX Host 1 (10.250.40.30) “All Virtual Machines”:
Small_vm

The **Target** tab presents the information on the location where the selected VM runs. Here is an example of the **Target** tab contents:

ESX Host 1 (10.250.40.30) “All Virtual Machines”:
Small_vm

### 12.2.3 Unmounting VMs

At the Mounted VMs view there are two control buttons in the context tool bar – **Unmount** and **Unmount & Save**.

When selecting a Virtual Machine in the Mounted VMs list, you can unmount it (stop running it from backup) by clicking the **Unmount** button.

Performing the **Unmount & Save** operation stops running the machine from the backup and commits all the changes made to this machine back into the archive adding a new recovery point to it.

### 12.3 Managing logs (View -> Show Logs)

Click **Show logs** in the **View** tab of the Acronis vmProtect main ribbon menu to open the **Logs** page.

#### 12.3.1 Logs list

The **Show Logs** view provides a list of events that have occurred on Acronis vmProtect Agent. This includes backup, restore, run VM from backup and other tasks as well as system messages such as establishing connection to managed ESX hosts/vCenter, etc.
The logs list contains the **Date/Time**, **Task name** and **Message** columns. You can sort the logs list by clicking the column header. For switching between the ascending and descending sort order click the column header one more time.

Also, you can filter the log events using several filters located above the list:

- Event flags (Success, Warning or Error).
- Date/Time.
- Task Name.

Click the log event in the list to see the detailed message for this log in the right window.

From the context tool bar, you can clear up the log events or set up automatic clean up rules to keep the size of the logs within the certain limits. These operations are described in the subsections below.

### 12.3.2 Log cleanup rules

Click the **Log Cleanup Rules** button in the main tool bar to set up your rules for keeping the log entries. In other words, this option specifies how to clean up the Acronis vmProtect agent log.
Select the check box in order to enable this **Log cleanup rules** option. Then, define the maximum size of the agent log folder (for example, in Windows XP/2003 Server %ALLUSERSPROFILE%\Application Data\Acronis\AVMP6\MMS\LogEvents).

Along with the **Maximum log size** value, you can set up the amount of log entries you want to keep.

The default values for **Log cleanup rules** settings are:

- **Maximum log size**: 50Mb.
- **Log size to keep after cleanup**: 95%.

The **Reset to defaults** button reverts these values for the preset.

When the **Log cleanup rules** option is enabled, then after every 100 log entries, the program will compare the actual log size with the pre-set **maximum log size**. Once the maximum log size is exceeded, the program deletes the oldest log entries. The default 95% setting will keep most of the log. With the minimum 1% setting, the log will be nearly cleared.

**12.3.3 Clear logs**

Click the **Clear Log** button in the main tool bar to erase all logs entries. This action will clear up all entries in the Acronis vmProtect logs. You will get the “Are you sure you want to clear the log?”
warning message in order to confirm the delete logs operation. Upon your confirmation, all logs will be cleared.

![Clear log dialog]

12.3.4 Save logs to file

Click the **Save to File** button in the ribbon bar to save the filtered log entries from the logs list. This operation allows you to get the .zip file with the selected logs and save it to your local PC. You may need to perform Save logs to file operation for troubleshooting the problems you might encounter.

You can also save all your Acronis vmProtect log entries history by clicking the **Save All to File** button.

12.4 Managing licenses (Configure -> Licenses)

Click **Licenses** in the **Configure** tab of the Acronis vmProtect main ribbon menu to open the **Licenses** page.

The **Licenses** view provides you with an overview of the licenses imported into the vmProtect Agent. Here you can **Add** the license serial numbers and **Remove** the binding of licenses to ESX hosts by using the corresponding buttons in the tool bar. Removing the license binding allows to free them up.
The licensing scheme in vmProtect implies that each CPU on the managed ESX host/cluster consumes a license.

At the first run of Acronis vmProtect there are no licenses bound to any ESX hosts/clusters. Here, you can add a new license as described below.

The imported (added) serial numbers may contain a number of licenses inside. The right section on the Licenses page shows the serial numbers list, the number of licenses, as well as their import date and expiration date.

The left section represents the list of the ESX hosts/clusters with some licenses bound. Licenses are bound to the ESX host/cluster upon first backup or restore operation with virtual machines running on this host. In case of a cluster, the licenses will be bound to all hosts included in this cluster. If a host is removed from the cluster, the license is not freed up automatically. You can remove the license binding by selecting the ESX host/cluster here and clicking on the Remove button in the tool bar. The licenses which were bound to this host will be free again and can be reused on another ESX host/cluster.

12.4.1 Adding license

You can add licenses by copy-pasting them into the corresponding field or by browsing the file with the licenses you would like to import. Acronis vmProtect supports .txt or .csv file format.
Upon adding new licenses you will get the following message indicating the number of licenses added.
12.4.2 Adding license failure

Adding a license may fail due to the following reasons:

- The license is already imported.
- The license is incorrect.

There could also be other problems. If you are sure that your license is a correct one but it still fails to be added, please contact Acronis support (p. 84).

12.4.3 Removing license/ESX host

Choose one of the ESX hosts/Clusters in the list and click the Remove button. The license assignment will be reset for the selected ESX host and the licenses will be freed up. The licenses will be automatically re-assigned to this host if you perform backup or restore operation with any of the machines running on this host.

You would have to confirm removing the license binding by choosing Yes in the dialog.
12.5 Managing ESX hosts (Configure -> ESX hosts)

Click ESX hosts in the Configure tab of the Acronis vmProtect main ribbon menu to open the ESX hosts page.

12.5.1 ESX hosts list

The Hosts view provides an overview and management interface for the ESX hosts/vCenters registered in the vmProtect Agent settings. The ribbon buttons allow you to add other ESX hosts to the list or remove them.

At the first run of Acronis vmProtect there are no registered ESX hosts/clusters. On this page you can add new ESX hosts as described below.

After adding an ESX host/vCenter, it will appear in the hosts list.
Adding an ESX host/vCenter will not bind the licenses to it automatically. It will be bound only when you execute a backup/restore task with a virtual machine running on this host. After you add an ESX host/vCenter you will be able to perform backup/recovery tasks with the virtual machines running on this ESX host/vCenter.

Removing an ESX host/vCenter will result in the disappearance of all tasks applied to virtual machines running on this ESX host/vCenter. If the task included virtual machines from different ESX hosts, then removing one of these ESX hosts from configuration will not remove the task.

In order to successfully manage an ESX host/vCenter, the login credentials are required. You can enter the credentials here, and they will be recorded until you remove the ESX host/vCenter or change the credentials manually. Changing the credentials operation may be required if your company policy requires changing passwords due to security restrictions. For that, select the ESX host/vCenter in the list and click the **Edit credentials** button on the right.

### 12.5.2 Adding ESX host

In order to add an ESX host/vCenter you have to provide the IP address/hostname and user credentials to access the desired ESX host/vCenter. You can check the connection with **Test connection** button to ensure that the provided credentials are correct. Click **Save** to add your ESX host/vCenter.
12.5.3 Adding an ESX host which is a part of vCenter

When you directly add an ESX host which is a part of vCenter instead of adding the vCenter itself, the main concern is that Acronis vmProtect Agent will not be able to track the changes made to the ESX host on behalf of the vCenter. This may cause unpredictable results. For example, if you run a VM from backup, upon unmounting, the temporary files will not be deleted from the ESX host since they will be locked by the vCenter. Therefore, it is strongly recommended that you add the vCenter instead of adding separate ESX hosts.

When you are trying to add an ESX host which is a part of vCenter, you will get the following warning message. Click No in order to add the vCenter.

12.5.4 Login credentials

Changing the credentials operation may be required if your company policy requires changing password due to security restrictions. Select the ESX host/vCenter is the list, click Edit credentials and provide the login/password information for the ESX host/vCenter connection. If you are running Acronis vmProtect in a domain environment, the username has to be specified in a
domain\username format. You can check the connection with the **Test connection** button to ensure that the provided credentials are correct. Click **OK** to add your ESX host/vCenter.

---

### 12.5.5 Removing ESX host

Removing an ESX host from Acronis vmProtect configuration may be required if you no longer want to perform backup/recovery operations over the virtual machines running on this ESX host. The licenses assigned to this host will not be removed automatically. To remove binding licenses, you have to go to Configure->Licenses (p. 71) page.

Removing an ESX host/vCenter will cause the existing tasks to malfunction; therefore, when doing so, you will be prompted with the following warning message:

“You are about to remove an ESX host/vCenter while there are backup or restore tasks associated with the virtual machines running on this host. Do you want to perform automatic adjustment of these tasks to reflect the changes in configuration (the associated tasks will be either removed or modified)? If you choose No, the tasks will remain intact but may not function properly due to the missing ESX host/vCenter.”

Choosing **Yes** will result in the disappearance of all Acronis vmProtect tasks applied to the virtual machines running on this ESX host/vCenter. If the task included virtual machines from different ESX hosts, this task will be automatically modified to remove unnecessary virtual machines from the task configuration. This leaves only the virtual machines which can be managed by the ESX hosts remaining in registration.
12.6 Managing settings

12.6.1 Managing Online Backup Proxy

Click **Online Backup Proxy** in the **Configure** tab of the Acronis vmProtect main ribbon menu to open the **Online Backup Proxy** settings page.

Online backup proxy settings are effective only for backup to and recovery from the Acronis Online Backup Storage over the Internet.

This option defines whether the Acronis agent will connect to the Internet through a proxy server.

Note that the Acronis vmProtect Online Backup Storage supports only HTTP and HTTPS proxy servers.
Managing settings, Online backup proxy

To set up proxy server settings:

Select the **Use a proxy server** check box.

- In **Address**, specify the network name or IP address of the proxy server, for example: `proxy.example.com` or `192.168.0.1`
- In **Port**, specify the port number of the proxy server, for example: 80
- If the proxy server requires authentication, specify the credentials in **User name** and **Password** fields.

To test the proxy server settings, click **Test connection**.

To apply the settings, click **Save**.

If you do not know the proxy server settings, contact your network administrator or Internet service provider for assistance.

Alternatively, you can try to find out what these settings are by looking in your Web browser’s configuration. This is how to find them in 3 popular browsers.

- Microsoft Internet Explorer. On the **Tools** menu, click **Internet Options**. On the **Connections** tab, click **LAN settings**.
- Mozilla Firefox. On the **Tools** menu (accessible through the main **Firefox** button, or by pressing the **Alt** button on the keyboard), click **Options** and then click **Advanced**. On the **Network** tab, under **Connection**, click **Settings**.

12.6.2 Managing Agent Password

Click the Agent Password button in the Configure tab of the Acronis vmProtect main ribbon menu to change your User password.

Here you can change the password for the user of Acronis vmProtect Agent. The username (login) cannot be changed. In order to change the password you have to first provide the old password and then enter and confirm the new password in the corresponding fields.

Note that Managing Agent Password option is available only when the Agent is installed as a Virtual Appliance (p. 11). For Windows Agent (p. 12) connection Acronis vmProtect uses Windows users accounts (any account with local logon permissions: user must be added to Allow log on locally security policy under Start->Secpol.msc->Local Policies->User Rights Assignment).

![Image of changing user password interface in Acronis vmProtect]
13 Best Practices

In this section we will give a few examples of some operations with Acronis vmProtect.

After you installed your Acronis vmProtect Agent you have to connect to it with your access credentials.

1. Add ESX host

First of all, to be able to perform backup and other operations, you have to specify the IP address/hostname and credentials for your vCenter or individual ESX host where your virtual machines are running. Click Configure ESX Hosts in the Dashboard’s Quick Start, or go to ESX Hosts view in the Configure menu and click Add. Specify the vCenter or ESX(i) server and its access credentials. Detailed information can be found in the "Managing ESX hosts" section (p. 75).

2. Add Licenses

Setting up an ESX host will not bind the licenses to it automatically. You have to follow to the Licenses page to set up your licenses. Click Configure Licenses in the Dashboard’s Quick Start, or click Licenses view in the Configure menu. Then click Add, and submit your license key. The detailed information can be found in the "Managing licenses" section (p. 71).

After that is done you can practically start backing up your virtual infrastructure.

13.1 Backing up virtual machines to a network share

Let’s discuss how to create a backup of several (for example, 5) virtual machines and save them over to a network share.

After setting up your ESX hosts and Licenses, you have to run the Create backup task wizard, which will guide you through all the steps of the backup process. Click Create Backup Task in the Dashboard’s Quick Start, or click Backup in the Home tab of the main menu. Then go through the New Backup Task wizard. Detailed information can be found in the "Creating a backup of virtual machines" section (p. 23).

On the step 1 of the New Backup Task wizard select your 5 virtual machines. Then on the step 2 browse the desired network share location where you would like to store your backup archives. On the steps 3 and 4 select the desired scheduling and backup method. And then finish the wizard. The created backup task will then perform what you needed to do. You can see the progress of this task in both Dashboard (View->Dashboard) and in Tasks (View->Tasks) views of Acronis vmProtect interface.

13.2 Restoring a backup of a virtual machine to a new location

So you’ve made your backup. Now let’s consider how to restore your backed up virtual machine, for example, to a new location.
In order to do that, you have to run the Restore backup task wizard which will guide you through all
the steps of the restore process. Click Restore in the Home tab of the main menu. Then go through
the wizard. The detailed information can be found in the "Restoring a backup of virtual machines"
section (p. 35).

On the first step of the wizard select a backed up virtual machine. On the step 2 select the desired
new location where you would like to restore your machine. On the step 3 select the preferences for
your restore task, and then finish the wizard. Click on Run Now to restore the machine right away or
Save to restore it later.

13.3 File/folders recovery

The first two cases show how to perform your backup and restore operations with Acronis
vmProtect. Let’s give one more example of how you could restore selected files from a specific
archive. That’s the case when you need to recover just a single file or just a few files from a backup
archive without restoring the whole virtual machine.

Run the File Recovery wizard by clicking the File Recovery in the Home tab of the main menu. On the
first step of the File Recovery wizard you need to select the recovery point for the virtual machine
which defines the VM state you want to extract files or folders from. Then on the second step select
the necessary files for recovery and click Download. The detailed information on File Recovery can
be found in the "File recovery" section (p. 43).

Let’s discuss another way to run the same wizard by accessing the recovery point directly from the
Recovery Points view. Go to the View tab and click Recovery Points. Select the Virtual Machine state
you want to recover your files from. After selecting the exact recovery point in the right section, click
the File Recovery button in the context menu. You will go to the File Recovery wizard where Step 1
will be already pre-filled with the selected recovery point and you would just have to click Next to go
to the Step 2. Then you have to select the files and/or folders you need to recover, and click
Download.
14 Support

14.1 Technical Support

Maintenance and Support Program
If you need assistance with your Acronis product, please go to http://www.acronis.com/support/

Product Updates
You can download the latest updates for all your registered Acronis software products from our website at any time after logging into your Account (https://www.acronis.com/my) and registering the product. See Registering Acronis Products at the Website (http://kb.acronis.com/content/4834) and Acronis Website User Guide (http://kb.acronis.com/content/8128).

14.2 Troubleshooting

When having any troubles using Acronis vmProtect or when contacting Acronis Technical Support, please save your working logs and send them to us. Please, go to Logs page (p. 68) and click Save All to File (p. 71).

15 Glossary

A

Agent (Acronis vmProtect Agent)
An application that performs backup and recovery of the virtual machines and enables other management operations on the VMWare ESX/ESXi infrastructure such as task management and operations with available backups, machines, etc.

Acronis vmProtect includes the Agent for backing up virtual machines residing on a VMWare ESX/ESXi virtualization server which the Agent is connected to. There could be several ESX/ESXi hosts or a vCenter managed by one Agent. The best practice is to register vCenter on the Agent instead of specific ESX/ESXi hosts which are managed by this vCenter. Otherwise, vMotion (p. 95) will not be supported.

The Agent component can be either Windows-based, i.e. installed on a Windows platform, or Appliance-based, i.e. running on a special virtual machine on an ESX host.

Always Incremental archive
A new generation of the archive (p. 85) format which may contain several backups (p. 85) from different virtual machines inside. All backups are saved to this archive in incremental mode (p. 92). Physically all data is located inside one file as opposed to Legacy mode archive format where each backup is stored in a separate TIB file. Here is the description of how the backups rotation is performed inside the Always Incremental archive:

When one backup becomes expired according to the pre-defined retention rules (which say for example to “delete all backups older than 5 days”), the program marks the old blocks which belong to the expired backup as “free” ones. The blocks of the expired backup which have any dependencies (they may be used in newer backups due to incremental backup technology) are not marked as “free” to ensure the archive consistency. The archive will still be taking the same space on the storage as before. However, newer backups saved into this archive will first write data to the “free” blocks and will increase the total size of the archive only when all the “free” blocks are used.

This approach allows us to keep the archive size as small as possible and prevents it from growing indefinitely.

Archive
See Backup archive (p. 86).
Backup

The result of a single backup operation (p. 86) as a single recovery point (p. 92) inside archive (p. 86). Physically, it is a file that contains a copy of the backed up data (virtual machine volumes) from specific date and time for a specific virtual machine. Backup files created by Acronis vmProtect have a TIB extension. One backup file may include useful data from multiple machines plus necessary metadata inside.

Backup archive (Archive)

A set of backups (p. 85) created and managed by a backup task (p. 87). An archive in Legacy mode format can contain multiple full backups (p. 91) as well as incremental (p. 92) and differential backups (p. 89). An archive of Always Incremental (p. 85) format can contain only incremental backups (the first backup will always be a full one). Backups belonging to the same archive are always stored in the same location. Multiple backup tasks can back up the same source data to the same archive, but a basic scenario is "one task – one archive".

Backups in an archive are managed by the backup task. Manual operations with archives (validation (p. 94), viewing contents, mounting and deleting backups) should be performed only using Acronis vmProtect. Do not modify your archives/backups using non-Acronis tools such as Windows Explorer or third-party file managers.

Backup operation

An operation that creates a copy of the data that exists on a machine's hard disk for the purpose of recovering or reverting the data to a specified date and time.

Backup options

Configuration parameters of a backup operation (p. 86), such as archive protection, source files exclusion or data compression level. Backup options are a part of a backup task (p. 87).

Backup scheme

A part of the backup task (p. 87) that includes the backup schedule, [optionally] the retention rules, and the cleanup (p. 88) schedule. For example: perform full backup (p. 91) monthly on the last day of the month at 10:00AM and incremental backup (p. 92) on Sundays at 10:00PM (for old generation format archive (p. 85)). Delete backups that are older than 3 months. Check for such backups every time the backup operation is completed. If the backup is performed in Always Incremental (p. 85) mode, then there is no need to define it's type, i.e. Full or Incremental.

Acronis vmProtect provides the ability to use well-known optimized backup schemes, such as GFS (p. 91), to create a custom backup scheme or to back up data once.
Backup task (Task)
A set of rules that specify how the given virtual machine or a set of virtual machines will be protected. A backup task specifies:

- What data to back up (i.e. which machines to back up).
- Where to store the backup archive (the backup archive name and location).
- The backup scheme, including the backup schedule and [optionally] the retention rules.
- [Optionally] the archive validation rules.
- The backup options.

For example, a backup task can contain the following information:

- Back up virtual machines “VM1”, “VM2” (this is the data the task will protect).
- Set the backup archive name as MySystemVolume and it’s location as \server\backups\.
- Perform a full backup monthly on the last day of the month at 10:00AM and an incremental backup on Sundays at 10:00PM (for old generation format archive (p. 85)). Delete backups that are older than 3 months (this is a backup scheme).
- Validate the last backup immediately after its creation (this is a validation rule).
- Protect the archive with a password (this is an option).

Physically, a backup task is a set of pre-defined actions configured for execution on the Agent (p. 85) side in accordance with the specified parameters (Backup Options (p. 86)).

Bootable agent
A bootable rescue utility that includes the backup functionality of the Acronis vmProtect Agent (p. 85). It's typically for P2V (p. 92) migration. Bootable agent is based on Linux kernel. A machine can be booted into a bootable agent using the bootable media (p. 87). Operations can be configured and controlled only locally through the GUI.

Bootable media
A physical media (CD, DVD, USB flash drive or other media supported by a machine BIOS as a boot device) that contains the bootable agent (p. 87).

Bootable media in Acronis vmProtect is used to back up a physical machine in order to perform P2V (p. 92) migration.
CBT (Changed Block Tracking)

A feature of VMWare ESX which allows to identify which blocks of the virtual disks have changed and to transfer only those blocks during the backup/replication process. For example when using CBT technology, the incremental backup speed can increase up to 20 times.

Cleanup

Deleting backups (p. 85) from a backup archive (p. 86) in order to get rid of outdated backups or prevent the archive from exceeding the desired size.

Cleanup consists of applying to an archive the retention rules set by the backup task (p. 87) that produces the archive. This operation checks if the archive has exceeded its maximum size and/or for expired backups. This may or may not result in deleting backups depending on whether the retention rules are violated or not.

For more information please refer to the User Guide (p. 27).

Console (Acronis vmProtect Management Console)

The console is the web-based user interface provided by the Acronis vmProtect Agent in order to access the product functionality. This interface is accessible from any supported Internet browser after you go to specified URL, for example https://192.168.0.23:9876/, where 192.168.0.23 is the IP address of Acronis vmProtect Agent (p. 85) and 9876 is the port. Using the direct web-based console-agent connection, the administrator performs direct management (p. 89).

Datastore

A logical container that holds virtual machine files and other files necessary for operations with virtual machine. Datastores can exist on different types of physical storage, including local storage, iSCSI, Fibre Channel SAN, or NFS. A datastore can be VMFS-based or NFS-based.

Deduplication

A method of storing different duplicates of the same information only once.

Acronis vmProtect can apply the deduplication technology to any backup archives (p. 86) of both Legacy mode (p. 92) and Always Incremental (p. 85) archive formats. This minimizes the storage space taken by the archives, backup traffic and network usage during the backup.
Deduplication in Acronis vmProtect is managing data within only one backup archive. For example if the backups are saved into 2 different archives (even if they are in the same location) then there will be no relations between these archives and they may contain duplicated data.

**Differential backup**
A differential backup stores changes to the data against the latest full backup (p. 91). You need access to the corresponding full backup to recover the data from a differential backup.

**Direct management**
Any management operation that is performed on the Agent (p. 85) using the console (p. 88)-agent (p. 85) connection.

**Disk group**
A number of dynamic disks (p. 90) that store the common configuration data in their Logical Disk Manager (LDM) databases and therefore can be managed as a whole. Normally, all dynamic disks created within the same machine are members of the same disk group.

As soon as the first dynamic disk is created by the LDM or another disk management tool, the disk group name can be found in the registry key
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\dmio\Boot Info\Primary Disk Group\Name.

The next created or imported disks are added to the same disk group. The group exists until there is at least one of its members. Once the last dynamic disk is disconnected or converted to basic, the group is discontinued, though its name is kept in the above registry key. In case a dynamic disk is created or connected again, a disk group with an incremental name is created.

When moved to another machine, a disk group is considered as ‘foreign’ and cannot be used until imported into the existing disk group. The import updates the configuration data on both the local and the foreign disks so that they form a single entity. A foreign group is imported as is (will have the original name) if no disk group exists on the machine.

For more information about disk groups, please refer to the following Microsoft knowledge base article:

**Distributed Resource Scheduler (DRS)**
A VMware vCenter specific feature which allows automatic load balancing of a ESX cluster using vMotion (p. 95).
Dynamic disk

A hard disk managed by Logical Disk Manager (LDM) that is available in Windows starting with Windows 2000. LDM helps flexibly allocate volumes on a storage device for better fault tolerance, better performance or larger volume size.

A dynamic disk can use either the master boot record (MBR) or GUID partition table (GPT) partition style. In addition to MBR or GPT, each dynamic disk has a hidden database where the LDM stores the dynamic volumes' configuration. Each dynamic disk holds the complete information about all dynamic volumes existing in the disk group which makes for better storage reliability. The database occupies the last 1MB of an MBR disk. On a GPT disk, Windows creates the dedicated LDM Metadata partition, taking space from the Microsoft Reserved Partition (MSR).

<table>
<thead>
<tr>
<th>Disk 1</th>
<th>MBR</th>
<th>LDM database</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Disk 2</th>
<th>Protective MBR</th>
<th>GPT</th>
<th>Microsoft Reserved Partition (MSR)</th>
<th>LDM database</th>
<th>GPT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>LDM Metadata partition</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 MB</td>
<td></td>
</tr>
</tbody>
</table>

Dynamic disks organized on MBR (Disk 1) and GPT (Disk 2) disks.

For more information about dynamic disks please refer to the following Microsoft knowledge base articles:

Disk Management (Windows XP Professional Resource Kit)

816307 Best practices for using dynamic disks on Windows Server 2003-based computers
http://support.microsoft.com/kb/816307.

Dynamic volume

Any volume located on dynamic disks (p. 90), or more precisely, on a disk group (p. 89). Dynamic volumes can span multiple disks. Dynamic volumes are usually configured depending on the desired goal:

- To increase the volume size (a spanned volume).
- To reduce the access time (a striped volume).
- To achieve fault tolerance by introducing redundancy (mirrored and RAID-5 volumes).

When backing up virtual machines which contain dynamic disks inside, Acronis vmProtect backs up the logical dynamic volumes instead of the entire dynamic disks structure.

E

**Encrypted archive**

A backup archive (p. 86) encrypted according to the Advanced Encryption Standard (AES). When the encryption option and a password for the archive are set in the backup options (p. 86), each backup belonging to the archive is encrypted by the agent (p. 85) before saving the backup to its destination.

The AES cryptographic algorithm operates in the Cipher-block chaining (CBC) mode and uses a randomly generated key with a user-defined size of 128, 192 or 256 bits. The encryption key is then encrypted with AES-256 using a SHA-256 hash of the password as a key. The password itself is not stored anywhere on the disk or in the backup file; the password hash is used for verification purposes. With this two-level security, the backup data is protected from any unauthorized access, but recovering a lost password is not possible.

F

**Full backup**

A self-sufficient backup (p. 85) containing all data selected for backup. To recover the data from a full backup, access to any other backup is not needed.

G

**GFS (Grandfather-Father-Son)**

A popular backup scheme (p. 86) aimed at maintaining the optimal balance between a backup archive (p. 86) size and the number of recovery points (p. 92) available from the archive. GFS enables recovering with daily resolution for the last several days, weekly resolution for the last several weeks and monthly resolution for any time in the past.

For more information please refer to GFS backup scheme.

H

**High Availability (HA)**

VMWare vCenter specific feature which, in case of cluster hardware failure, allows to automatically restart the virtual servers on another host in the cluster.
I

Incremental backup
A backup (p. 85) that stores changes to the data against the latest backup. You need access to other backups from the same archive (p. 85) to restore data from an incremental backup.

L

Legacy mode Archive
See Backup archive (p. 86).

M

Machine (Virtual machine)
A virtual computer uniquely identified by an operating system installation.

Media builder
A dedicated tool for creating bootable media (p. 87).

P

P2V
Migration of physical machine to virtual environment. Typically P2V process includes the following steps:
- Create a backup of physical machine using special bootable media (p. 87).
- Restore it to virtual environment (ESX/ESXi server).

R

Recovery point
Date and time to which the backed up data can be reverted to.
Registered machine
A virtual machine managed by Acronis vmProtect Agent. All virtual machines which reside on the registered ESX/ESXi host or vCenter are automatically registered and can be managed by Acronis vmProtect Agent.

Replication
A process of replicating the virtual machine to new location (new datastore and/or resource pool). As the result of this process there will be a duplicate virtual machine created which is running independently from the original one.

Resource Pool
A VMWare term describing the concepts of resource management in an ESX virtualized environment. A resource pool provides a way to divide the resources of a stand-alone ESX host or an ESX cluster into smaller pools. A resource pool is configured with a set of CPU and memory resources that the virtual machines that run in the resource pool share. Resource pools are self-contained and isolated from other resource pools.

One can combine multiple physical servers into a single resource pool that aggregates CPU and memory capacity.

Virtual machines execute in, and draw their resources from, resource pools. This arrangement allows virtual machine workloads to continuously balance across resource pools. When the workload increases, the vCenter Server automatically allocates additional resources and transparently migrates virtual machines between hosts in the resource pool.

S
Storage vMotion
VMWare vCenter specific feature which allows moving a running virtual machine from one storage device to another.

T
Task
In Acronis vmProtect, a task is a sequence of actions to be performed on a registered machine at a certain time or when a certain event occurs. The actions are described in an xml script file. The start condition (schedule) exists in the protected registry keys (for Windows-based Agent) or in protected files (for Appliance-based Agent).
Universal Restore (Acronis Universal Restore)
The Acronis proprietary technology that helps boot up Windows on dissimilar hardware or a virtual machine. The Universal Restore handles differences in devices that are critical for the operating system start-up, such as storage controllers, motherboard or chipset.

In Acronis vmProtect the Universal Restore technology is primarily used for P2V (p. 92) migration scenarios.

Universal Restore is not available when recovering Linux.

Validation
An operation that checks the possibility of data recovery from a backup (p. 85).

Validation of a virtual machine backup calculates a checksum for every data block saved in the backup. This procedure is resource-intensive.

While the successful validation means a high probability of successful recovery, it does not check all factors that influence the recovery process. If you back up the operating system, only a test recovery to new/existing virtual machine or running virtual machine from the backup can guarantee successful recovery in the future.

Validation rules
A part of the backup task (p. 87). Rules that define when and how often to perform validation and whether to validate the entire archive (p. 85) or the latest backup in the archive.

vApp
A group of virtual machines that can be managed as a single object. vApps simplify management of complex, multi-tiered applications that run on multiple interdependent virtual machines. vApps have the same basic operations as virtual machines and resource pools. With vApps, you can set the order in which the virtual machines in the vApp power on, automatically assign IP addresses to virtual machines in the vApp, and provide application-level customization.

In terms of Acronis vmProtect product the “vApp” is considered to be a container for VMs. This container has its own properties which are included into the backup and are restored along with vApp once some parts of it (or entire vApp) are restored.
vCenter

VMware vCenter Server, formerly VMware VirtualCenter, centrally manages VMware vSphere environments allowing IT administrators dramatically improved control over the virtual environment compared to other management platforms.

See more details at http://www.vmware.com/products/vcenter-server/.

In terms of Acronis vmProtect product the “vCenter” item is considered to be a container for the ESX virtual infrastructure including datacenters, ESX hosts, etc.

vMotion

A VMWare vCenter specific feature which allows the migration of operational guest virtual machines between similar but separate hardware hosts sharing the same storage. Each of these transitions is completely transparent to any users on the virtual machine at the time it is being migrated.